Contents

Preface .......................................................... 11
Purpose of This Tutorial .................................... 11
Audience ....................................................... 12
How to Use This Tutorial .................................... 12
  Understanding the Sample Design Files .................. 13
  Understanding the Multimedia Demonstrations ........ 13
Tutorial Flow .................................................. 14
Related Information .......................................... 18
Syntax Conventions ......................................... 19

About Allegro PCB Editor .................................. 21
  Allegro PCB Editor Tools .................................. 21
  Allegro PCB Editor Initialization ....................... 23
  env File .................................................... 24
  Cadence File Types ....................................... 25
  Allegro PCB Editor Database ......................... 28
  Operating System Differences ......................... 28
  Requirements for a New Design ....................... 29
    Design Entry HDL ...................................... 29
    Allegro Design Entry CIS ............................. 31
    Third-Party Netlist .................................. 34
  Allegro PCB Editor Flow .................................. 38
    Menu Items and Corresponding Commands .......... 43
  Sources of Information ................................ 44
    SourceLink ............................................ 44
    Cadence Customer Response Center ................ 45
    Education Services ................................... 45
# Module 1: Getting Started with Allegro PCB Editor

## Lesson 1-1: Creating a Project Directory
- **Overview**: 47
- **Procedure**: 50
- **Summary**: 51
- **For More Information**: 51
- **What's Next**: 51

## Lesson 1-2: Starting Up Allegro PCB Editor
- **Overview**: 51
- **Procedure**: 52
- **Summary**: 53
- **For More Information**: 53
- **What's Next**: 53

## Lesson 1-3: Setting Your Working Directory and Opening a Design
- **Overview**: 54
- **Demo**: 54
- **Procedure**: 54
- **Summary**: 55
- **For More Information**: 56
- **What's Next**: 56

## Lesson 1-4: Accessing the Help System
- **Overview**: 56
- **Demo**: 57
- **Procedure**: 57
- **Demo**: 59
- **Procedure**: 60
- **Demo**: 62
- **Procedure**: 62
- **Summary**: 63
- **What's Next**: 63
Module 2: Introducing the Allegro PCB Editor User Interface

Lesson 2-1: Identifying Parts of the User Interface

Overview
Demo
Procedure
Summary
For More Information
What's Next

Lesson 2-2: Accessing Pop-up Menus and Panning a Design

Overview
Demo
Procedure
Summary
For More Information
What's Next

Lesson 2-3: Zooming In and Out of a Design

Overview
Demo
Procedure
Summary
For More Information
What's Next

Lesson 2-4: Using Other Methods to Zoom In and Out of a Design

Overview
Demo
Procedure
Summary
For More Information
What's Next
Module 3: Using Allegro PCB Editor Control Functions

Lesson 3-1: Changing the Cursor Display

Overview

Demo

Procedure

Summary

For More Information

What's Next

Lesson 3-2: Controlling Color and Visibility

Overview

Demo

Procedure

Demo

Procedure

Demo

Procedure

Summary

For More Information

What's Next

Lesson 3-3: Controlling Etch Visibility

Overview

Demo

Procedure

Summary

For More Information

What's Next

Lesson 3-4: Controlling Colors and Dimming Graphics

Overview

Demo

Procedure

Summary

For More Information

What's Next

Lesson 3-5: Using the Control Panel to Manipulate Design Objects
Module 4: Using Allegro PCB Editor Design Editing Functions

Lesson 4-1: Naming a Symbol and Setting Drawing Parameters
  Overview .......................................................... 126
  Demo ............................................................... 126
  Procedure ......................................................... 126
  Summary ........................................................... 129
  For More Information ........................................... 129
  What's Next ....................................................... 129

Lesson 4-2: Setting the Grid for a Design
  Demo ............................................................... 130
  Procedure ......................................................... 130
  Summary ........................................................... 131
  For More Information ........................................... 132
  What's Next ....................................................... 132

Lesson 4-3: Creating a Board Outline
  Demo ............................................................... 132
  Procedure ......................................................... 132
  Summary ........................................................... 136
  For More Information ........................................... 136
  What's Next ....................................................... 136

Lesson 4-4: Choosing Drawing Options
  Demo ............................................................... 137
  Procedure ......................................................... 137
  Summary ........................................................... 142
  For More Information ........................................... 143
  What's Next ....................................................... 143

Lesson 4-5: Defining the Stackup
  Demo ............................................................... 143
  Procedure ......................................................... 144
  Summary ........................................................... 147
5
Module 5: Customizing the Environment ........................................ 159
Lesson 5-1: Customizing Your View and Toolset .............................. 159
  Overview ............................................................................. 159
  Demo ............................................................................... 160
  Procedure ......................................................................... 160
  Summary ............................................................................ 164
  For More Information .......................................................... 164
  What's Next ....................................................................... 164
Lesson 5-2: Defining Aliases and Function Aliases .......................... 164
  Overview ............................................................................. 164
  Demo ............................................................................... 165
  Procedure ......................................................................... 165
  Summary ............................................................................ 167
  For More Information .......................................................... 167
  What's Next ....................................................................... 167
Lesson 5-3: Setting Environment Variables ..................................... 167
  Overview ............................................................................. 167
  Demo ............................................................................... 168
  Procedure ......................................................................... 168
  Summary ............................................................................ 169
  For More Information .......................................................... 170
  What's Next ....................................................................... 170
Lesson 5-4: Running Commands with Strokes ................................ 170
  Overview ............................................................................. 170
  Demo ............................................................................... 171
  Procedure ......................................................................... 171
  Summary ............................................................................ 173
  For More Information .......................................................... 173
  What's Next ....................................................................... 173
Lesson 5-5: Scripting ................................................................... 173
  Overview ............................................................................. 173
  Demo ............................................................................... 174
  Procedure ......................................................................... 174
  Demo ............................................................................... 176
## Allegro PCB Editor Tutorial

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procedure</td>
<td>177</td>
</tr>
<tr>
<td>Demo</td>
<td>177</td>
</tr>
<tr>
<td>Procedure</td>
<td>177</td>
</tr>
<tr>
<td>Summary</td>
<td>178</td>
</tr>
<tr>
<td>For More Information</td>
<td>178</td>
</tr>
<tr>
<td>What's Next</td>
<td>179</td>
</tr>
<tr>
<td>Lesson 5-6: Using Color Visibility Views</td>
<td>179</td>
</tr>
<tr>
<td>Overview</td>
<td>179</td>
</tr>
<tr>
<td>Demo</td>
<td>179</td>
</tr>
<tr>
<td>Procedure</td>
<td>179</td>
</tr>
<tr>
<td>Summary</td>
<td>181</td>
</tr>
</tbody>
</table>

## Appendix A: List of Demonstrations

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix A: List of Demonstrations</td>
<td>183</td>
</tr>
</tbody>
</table>
Preface

This preface discusses the following topics:

- **Purpose of This Tutorial** on page 11
- **Audience** on page 12
- **How to Use This Tutorial** on page 12
- **Tutorial Flow** on page 14
- **Related Information** on page 18
- **Syntax Conventions** on page 19

**Purpose of This Tutorial**

The Allegro PCB Editor Tutorial provides lessons, a sample design file, and multimedia demonstrations to help you learn how to work with Allegro PCB Editor and APD. The goal of this tutorial is to acquaint you with the Allegro PCB Editor and APD environment and some of its basic functions. The tutorial does not cover the process of developing a printed board design.

This tutorial is based on Release 15.0. However, when appropriate, the procedures include steps that you can use if you are running a later version. You should expect to spend approximately sixteen hours to complete the lessons in this tutorial.

The tutorial contains these modules:

- **Module 1: Getting Started with Allegro PCB Editor**
- **Module 2: Introducing the Allegro PCB Editor User Interface**
- **Module 3: Using Allegro PCB Editor Control Functions**
- **Module 4: Using Allegro PCB Editor Design Editing Functions**
- **Module 5: Customizing the Environment**
For details on the modules, see the Tutorial Flow on page 14.

**Audience**

This tutorial is intended to train users who have design experience with other tools but are new users to the Allegro PCB Editor and APD, or serve as a refresher learning tool for infrequent users. To work successfully with the editor, you must have a basic knowledge of printed circuit board (PCB) design.

**How to Use This Tutorial**

The training is offered in three learning modes:

- Written lessons provide detailed procedures for performing basic operations.
- Multimedia presentations demonstrate the written procedures.

Links to demonstrations are available at the beginning of each procedure. Also a list of all the demonstrations and links is available in Appendix A: List of Demonstrations on page 183.

- Sample design files offer a starting point for practicing with the tools.

Depending on your personal learning style, you can use this tutorial in different ways:

- You might begin by reading through the written tutorial lessons. After completing each lesson, watch the multimedia demonstration to enhance your understanding of the procedures. Then, work through the procedures yourself using the sample design files with the editor.

- Another approach you can take is to watch the multimedia demonstrations first to gain a general understanding of how to work with the tools. Then, as you experiment with the sample files using the editor, you can refer to the written lessons to refresh your memory about procedures you saw in the demonstrations.
The written lessons, demonstrations, and sample designs all work together to reinforce your learning experience. Use them in the way that is most comfortable and efficient for you to learn the fundamentals of working with Allegro PCB Editor.

Understanding the Sample Design Files

The sample design files, `cds_routed.brd` and `cds_routed_DRC.brd` are basic printed circuit boards that you can load and use to begin working with Allegro PCB Editor. The tutorials and multimedia demonstrations use these same design files to illustrate the procedures. You can work with the design files as you progress through the lessons.

To locate the files, see the `<installation_directory>\doc\algrotutorial\examples` directory.

Understanding the Multimedia Demonstrations

The multimedia demonstrations that accompany the tutorial lessons offer visual ways to grasp concepts and techniques that are described in the procedures. The demonstrations support and illustrate the procedures.

You can launch the multimedia demonstrations in two ways:

- Click on the hyperlink in the Demo section that precedes the procedure for each lesson.
- Go to Appendix A: List of Demonstrations on page 183 and click the hyperlink for the demo that you want to run.

Getting the Flash Player

To view the multimedia demonstrations, you need to install the appropriate Macromedia Flash Player on your system. Macromedia Flash Player for different operating systems is free and available at:

http://www.macromedia.com/shockwave/download/alternates/

You can download the appropriate Macromedia Flash Player for Windows, Solaris, HP-UX, and Linux operating systems.
Important

The multimedia demonstrations included in this tutorial do not run on the IBM AIX operating system. However, the tutorials have been designed to be used without viewing the demonstrations. You can follow procedures in the lessons while you perform the tasks using the sample designs.

Viewing a Multimedia Demonstration

To see how to control a Flash multimedia demonstration, click on this link to view a demonstration:

Controlling a Flash Multimedia Demonstration

Depending on the demonstration, audio may be included. If a multimedia demonstration contains audio, the link launching shows these logos: 🎧 🎧.

Note: To hear audio in a Windows-based system, ensure that the Volume icon in the task bar is on.

Tutorial Flow

In addition to the chapter, About Allegro PCB Editor, which provides some basic information about the product, this tutorial consists of the modules and lessons shown in Figure 1-1.
Figure 1-1 Modules and Lesson

Module 1
Getting Started

| Lesson 1-1 | Creating a Project Directory |
| Lesson 1-2 | Starting Up |
| Lesson 1-3 | Setting a Working Directory and Opening a Design |
| Lesson 1-4 | Accessing the Help System |

Module 2
Introducing the User Interface

| Lesson 2-1 | Identifying Parts of the User Interface |
| Lesson 2-2 | Accessing Pop-up Menus and Panning a Design |
| Lesson 2-3 | Zooming In and Out of a Design |
| Lesson 2-4 | Using Other Methods to Zoom In and Out of a Design |
Module 3
Using Control Functions

Lesson 3-1
Changing the Cursor Display

Lesson 3-2
Controlling Color and Visibility

Lesson 3-3
Controlling Etch Visibility

Lesson 3-4
Controlling Colors and Dimming Graphics

Lesson 3-5
Using the Control Panel to Manipulate Design Objects

Lesson 3-6
Highlighting Objects

Lesson 3-7
Listing Detailed Information About a Specified Object

Lesson 3-8
Measuring Distance Between Objects
Related Information

At the end of each lesson, you will find hyperlinks to related sections of the Allegro PCB Editor User Guide, Allegro Package Designer User Guide, and the Allegro PCB and Package Physical Layout Command Reference. You can also access these manuals from the Help menu.
Syntax Conventions

This list describes the syntax conventions used in this tutorial.

<table>
<thead>
<tr>
<th>Font</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>literal</td>
<td>Key words that you must enter literally. These keywords represent commands</td>
</tr>
<tr>
<td></td>
<td>(functions, routines) or option names.</td>
</tr>
<tr>
<td>Courier font</td>
<td>Indicates command line examples.</td>
</tr>
<tr>
<td>UI</td>
<td>Words in this font refer to menus, labels, fields, or tabs on the user</td>
</tr>
<tr>
<td></td>
<td>interface.</td>
</tr>
<tr>
<td>variable</td>
<td>Words in this font refer to arguments for which you must substitute a value.</td>
</tr>
</tbody>
</table>
About Allegro PCB Editor

This chapter provides some basic information about the Allegro PCB Editor and APD that you can review before starting the lessons in this tutorial.

Throughout this tutorial, references are made to Allegro PCB Editor and APD. However, most of the Cadence Silicon Package Board (SPB) products – APD, and Allegro PCB SI – are built on the same base. These other tools have additional functionality that is not shared with Allegro PCB Editor, but the method to interact with the design is the same.

The chapter discusses these topics:

- **Allegro PCB Editor Tools** on page 21
- **Allegro PCB Editor Initialization** on page 23
- **env File** on page 24
- **Cadence File Types** on page 25
- **Allegro PCB Editor Database** on page 28
- **Table 2-2** on page 28
- **Requirements for a New Design** on page 29
- **Allegro PCB Editor Flow** on page 38
- **Allegro PCB Editor Menus and Functions** on page 41
- **Sources of Information** on page 44

**Allegro PCB Editor Tools**

Based on the licenses you have purchased and the product choices made by the installer, you may have access to these tools:
Allegro PCB Editor Tutorial
About Allegro PCB Editor

- Allegro PCB Editor – Used to create and modify PCB designs. Based on whether you are in layout mode or in symbol creation mode, the editor appears with a specific menu set.

- Constraint Manager – A spreadsheet-based product, which acts as a command center for the correct-by-design process and can be used with Allegro PCB Design 610 and Allegro PCB Design 220. The Constraint Manager establishes, manages, reviews, and validates electrical design rules or constraints that control interconnect signal quality. This powerful tool allows you to graphically create, edit, and review topology templates or electronic blueprints. It provides real-time updates of the spreadsheets, and automatically integrates the results for you.

- Padstack Designer – A graphical user interface that lets you create and visualize multi-layer padstacks. This tool eases the definition of complex padstack geometries by visualizing the padstack from the cross-section and plane views.

- Allegro PCB Router – A tool that handles high-density printed circuit boards requiring complex design rules. The Allegro PCB Router uses powerful, shape-based algorithms to efficiently use the routing area. In addition, the Allegro PCB Router integration with Allegro PCB Editor layout, Allegro PCB SI, and APD provides high-speed constraint management across the entire design flow.

- Allegro PCB SI – A tool that offers an integrated high-speed design and analysis environment for creating digital PCB systems and integrated circuit (IC) package designs. Allegro PCB SI allows you to explore and resolve electrical performance-related issues in all stages of the design cycle. By exploring and making trade-offs among timing, signal integrity, crosstalk, power delivery, and EMI, you can optimize electrical performance before committing to final design for manufacture.

- Allegro Package Designer XL (APD) – A tool that uses the SpiderRoute autorouting technology for complex, high-density interconnect IC packages. APD SpiderRoute complements the already robust IC packaging routing environment, which includes the Allegro PCB Router, by providing innovative algorithms for supporting all chip-attach technology. APD SpiderRoute provides IC package designers with true any-angle, multi-layer routing capability, concurrent routing, pre-route feasibility, and on-the-fly pin swap.
Online documentation.

Also installed is a number of programs that you can run from an operating system prompt. These programs may display graphical user interfaces when run, or may require that you enter arguments and options from the keyboard.

Allegro PCB Editor Initialization

When you start Allegro PCB Editor, it reads these files:

- env
- allegro.ini
- allegro.ilinit

The environment (env) file, located in the pcbenv directory, determines the location of libraries, menus, forms, scripts, other Allegro PCB Editor directory pathnames, and keyboard assignments (aliases). Allegro PCB Editor reads the allegro.ini text file, located in the same directory. This file stores various settings such as the toolbar setting window size, plotting setup, and so on. You should not edit this file, but if you delete it, the editor restores the default settings.

At startup, Allegro PCB Editor also searches for the allegro.ilinit file. This file contains the location of the SKILL directory and loads the SKILL commands for use. The directory search order is:

$CDSROOT/sharepcb/etc/skill;$ALLEGRO_SITE/skill;$HOMEpcbenv;
Figure 2-1 Allegro PCB Editor Initialization

env File

When you start Allegro PCB Editor, it looks for a $HOME/pcbenv directory. If it does not find one, it creates a pcbenv directory with startup files such as env file, allegro.ini, and allegro.geo, at a location determined by the value of the environment variable HOME. The .geo and .ini files store your window and toolbar preferences.
If you have not explicitly set a \texttt{HOME} variable, the Allegro PCB Editor uses a combination of the \texttt{HOMEDRIVE} and \texttt{HOMEPATH} variables to generate the home directory (\texttt{HOMEDRIVE: \textbackslash HOMEPATH}) on Windows. If the \texttt{HOMEDRIVE} and \texttt{HOMEPATH} variables do not exist, the editor uses \texttt{C:\}. 

\textbf{Caution}

\textit{Do not edit the files in your \texttt{pcbenv} directory. Instead, use the User Preferences Editor dialog box to set environment variables. See Lesson 5-3: Setting Environment Variables on page 167 for information on performing this task. If your home directory is inaccessible or write-protected, you cannot save any of your preferences.}

### Cadence File Types

Cadence supports the file types described in Tables 2-1 and 2-2.

#### Table 2-1 Allegro PCB Editor Database Objects

<table>
<thead>
<tr>
<th>If the File Has This Extension...</th>
<th>It Is a...</th>
<th>And You Use This Tool...</th>
</tr>
</thead>
<tbody>
<tr>
<td>.brd</td>
<td>PCB design database file.</td>
<td>Allegro PCB Editor with Layout menus</td>
</tr>
<tr>
<td>.dra</td>
<td>Drawing file. You must create this file before you create a symbol file. Later, this file is compiled into a binary symbol file.</td>
<td>Allegro PCB Editor – Allegro Package</td>
</tr>
<tr>
<td>.pad</td>
<td>Padstack file.</td>
<td>Padstack Editor</td>
</tr>
<tr>
<td>.mcm</td>
<td>Multi-chip module design file.</td>
<td>APD</td>
</tr>
<tr>
<td>.osm</td>
<td>Library file that stores format symbols such as a legend or a company logo.</td>
<td>Allegro PCB Editor – Allegro Format</td>
</tr>
<tr>
<td>.psm</td>
<td>Library file that stores package/part symbols, for example, an IC.</td>
<td>Allegro PCB Editor – Allegro Package</td>
</tr>
</tbody>
</table>
Allegro PCB Editor supports the reports, input files, and output files described in Table 2-2.

### Table 2-2 Reports, Input Files, and Output Files

<table>
<thead>
<tr>
<th>If the File Has This Extension...</th>
<th>It Is a...</th>
<th>And You Use This Tool...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>.bsm</strong></td>
<td>Library file that stores drawing or board/substrate symbols, for example, a board or design outline.</td>
<td>Allegro PCB Editor – Allegro Mechanical</td>
</tr>
<tr>
<td><strong>.fsm</strong></td>
<td>Library file that stores flash symbols such as a thermal pad for raster formats.</td>
<td>Allegro PCB Editor – Allegro Flash</td>
</tr>
<tr>
<td><strong>.ssm</strong></td>
<td>Library file that stores shape symbols such as a special shape for a padstack.</td>
<td>Allegro PCB Editor – Allegro Shape</td>
</tr>
<tr>
<td><strong>.mdd</strong></td>
<td>Library file that stores module definitions.</td>
<td>Allegro PCB Editor – with Layout menus</td>
</tr>
<tr>
<td><strong>.dsn</strong></td>
<td>A file created by translating design information from the layout system. It contains PCB boundary data, layer definitions, padstack definitions, component data, netlist, preroutes, and design rules.</td>
<td>Allegro PCB Router</td>
</tr>
</tbody>
</table>

Allegro PCB Editor supports the reports, input files, and output files described in Table 2-2.
<table>
<thead>
<tr>
<th>If the File Has This Extension...</th>
<th>It Is...</th>
<th>Function/Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>.txt</td>
<td>A text file, for example, art_param.txt, that describes machine-related parameters or art_aper.txt that lists the size and shape of each aperture according to aperture wheel.</td>
<td>ASCII text files created during the various processes. The example files are created when the design is ready for manufacturing.</td>
</tr>
<tr>
<td>.scr</td>
<td>A script or macro file used to play back recorded tasks.</td>
<td>Created during script creation.</td>
</tr>
<tr>
<td>.il</td>
<td>A SKILL script.</td>
<td>Created with SKILL commands to provide automatic functions.</td>
</tr>
<tr>
<td>.log</td>
<td>A log file that contains data on processes.</td>
<td>Created during the specific process.</td>
</tr>
<tr>
<td>.art</td>
<td>An artwork file for selected film records.</td>
<td>Created when the design is ready for manufacturing.</td>
</tr>
<tr>
<td>.dat</td>
<td>A data file, such as the import logic files: pstnet.dat, pstxprt.dat, and pstchips.dat, or the export logic files: compview.dat, netview.dat, and funcview.dat.</td>
<td>Created during the various processes. The example files are created by the front-end tools and by Allegro PCB Editor.</td>
</tr>
<tr>
<td>.jrl</td>
<td>A journal file which contains a record of events — menu picks, keyboard activity, and so on.</td>
<td>Recorded for each session in the editor.</td>
</tr>
<tr>
<td>.do</td>
<td>An Allegro PCB Router script file containing rules and Allegro PCB Router commands.</td>
<td></td>
</tr>
<tr>
<td>.did</td>
<td>An Allegro PCB Router output file that contains design rules such as clearance, wiring, timing, cross-talk, and so on.</td>
<td>Generated when you run an automatic routing command on a design.</td>
</tr>
</tbody>
</table>
### Allegro PCB Editor Database

The Allegro PCB Editor database is binary; the format changes with each major release, for example, from 14.x to 15.x. The current database can be read by later releases, but not by earlier releases. You can use the `uprev` command to convert a database for use by a later release.

See the `uprev` command in the *Allegro PCB and Package Physical Layout Command Reference* for additional information. You can use the `extracta` command to obtain textual information from the database. See the *Completing the Design* user guide in your documentation set for additional information.

### Operating System Differences

The differences between using the Allegro PCB Editor on Windows or on UNIX are:

- **Use of slashes in pathnames.**
  
  UNIX uses forward slashes in pathnames. Windows uses backslashes in pathnames.

- **Allegro PCB Editor startup is different on UNIX and Windows.**
  
  See *Lesson 1-2: Starting Up Allegro PCB Editor* on page 51.

**Note:** Neither UNIX nor Windows currently supports embedded spaces within a file name. You can open the Allegro PCB Editor `brd` files on either operating system.
Requirements for a New Design

You can create a design in the Allegro PCB Editor by importing logic from:

- Allegro Design Entry HDL schematic or netlist
- Allegro Design Entry CIS schematic or netlist
- Third-party netlist

Design Entry HDL

After the schematic is created in Allegro Design Entry HDL XL, the Packager-XL utility combines the logic devices with physical packages, assigning a reference designator and physical pin numbers to each symbol in the schematic. The packaged parts and their connections are written into transfer files (Figure 2-2 and Table 2-3). These files transfer information from the schematic to an Allegro PCB Editor design.

Figure 2-2 Transfer Files (pst*.dat) for Traditional Flow

```plaintext
pstxprt.dat
FILE_TYPE=EXPANDED_PART_LIST;
{ Packager-XL run 03-May-2002 A
DIRECTIVES
SCH_FILE='C:\users\alu\mynets\alu.sch';
SOURCE_ROUT='74L500';
END_DIRECTIVES
PART_NAME='74L500';
UIT='74L500';
SCH_FILE='alu.sch';
END_PART

psxtmp.dat
FILE_TYPE=LIBRARY_PARTS;
primitive '74L500';
pin 'B'<0>
INPUT_LOAD='(-0.4,0.02)';
PIN_NUMBER='(13,10,5,2)';
PIN_GROUP='1';
'A'<0>
INPUT_LOAD='(-0.4,0.02)';
PIN_NUMBER='(12,9,4,1)';
PIN_GROUP='1';
'C'<0>
OUTPUT_LOAD='(0.8,-0.4)';
PIN_NUMBER='(11,8,6,3)';
end pin

psxtchip.dat
FILE_TYPE=LIBRARY_PARTS;
primitive '74L500';
BODY_NAME='L74L500';
PART_NAME='74L500';
JEDEC_TYPE='SOIC-14';
```
Note: If you are using the traditional flow, which means that you are not using the Constraint Manager with Allegro Design Entry HDL XL, Allegro PCB Editor reads pstxprt.dat, pstxnet.dat, and pstchip.dat netlist (output) files from Allegro Design Entry HDL. In the Constraint Manager-enabled flow, the Allegro PCB Editor reads pstxprt.dat, pstxnet.dat, pstchip.dat, pstcmdb.dat, and pstcmbc.dat files. Based on information contained in these files, Allegro PCB Editor produces or updates an Allegro PCB Editor layout file.

### Table 2-3 Descriptions of Transfer File for Traditional Flow

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
</table>
| pstxprt.dat  | An expanded parts list file that lists each physical package (created by the Packager-XL) in the schematic with its reference designator and device type. For packages comprised of multiple logic gates, this file identifies which gate is placed in which section of the physical package.  
  This file may also contain some properties attached to parts in the schematic, such as ROOM='IF', VALUE='4.7K'. |
| pstxnet.dat  | An expanded netlist file that uses keywords (net_name, node_name) to specify the reference designators and pin numbers associated with each net in the schematic.  
  This file may also contain some properties attached to nets in the schematic, such as ROUTE_PRIORITY, ECL, and so on. |
| pstchip.dat  | A device definition file (chips) that contains electrical characteristics (for example, pin direction and loading), logical-to-physical pin mapping, and voltage requirements. It defines the number of gates in a device, including gate and pin swapping information.  
  This file also contains the name of the package symbol that represents this device type in the physical layout (such as JEDEC_TYPE='DIP14_3', ALT_SYMBOLS=('T:SOIC14')). |
Figure 2-3  Allegro Design Entry HDL XL-Integrated Logic Design with Physical Layout

Allegro Design Entry CIS

Figure 2-4 shows the front-to-back integration between Allegro Design Entry CIS and the Allegro PCB Editor tools.
Allegro Design Entry CIS: It is not required that the Allegro Design Entry CIS schematic resides in the same directory as the Allegro PCB Editor design. However, it is recommended that you keep the two together.

Annotate: The Annotate program converts the logic devices into physical packages, assigning a reference designator and physical pin numbers to each symbol in the schematic.

Netlister: The Netlister creates the transfer files used by the Allegro PCB Editor. By default, these files are: pstxnet.dat, pstxprt.dat, and pstchips.dat.
Allegro PCB Editor

**Import Logic**: After you import logic, the design contains connection information.

**Allegro PCB Editor**: This tool places pin and gate swaps for optimum routing results, routes, and generates manufacturing output.

**Export Logic**: This program generates backannotation files that Allegro Design Entry CIS uses to update the schematic.

**Figure 2-5 Allegro Design Entry CIS Interface with Allegro PCB Editor**

The Netlister (PXLlite) reads the Allegro Design Entry CIS database and creates the same format .pst files as the Packager-XL routine. Therefore, Allegro PCB Editor can use the same program to read in either an Allegro Design Entry CIS schematic or an Allegro Design Entry HDL schematic.
Allegro PCB Editor performs backannotation. Then, Allegro Design Entry CIS reads these files and updates the schematic to reflect any changes made to the design by the Allegro PCB Editor, such as pin and gate swapping, reference designator changing, and so on.

### Third-Party Netlist

If you have not used Allegro Design Entry HDL or Allegro Design Entry CIS to generate the schematic, you must use a netlist and device files.

The netlist contains the part and connectivity data. Device files are library files that describe the parts in the netlist (one device file per device type). Allegro PCB Editor reads the netlist into a design and produces a log file that lists any errors found in the netlist or device files.

You can also generate a backannotation file to return data back to the third-party system.

When it reads the netlist, the looks at the `devpath` environment variable to locate the device files required.

### Netlist

The netlist contains two main sections (Figure 2-6): PACKAGES and NETS. The PACKAGES section contains a parts list; the section begins with `$PACKAGES`. You must identify each reference designator in the design in this section.

The NETS section contains all the nets in the design and the pin connections for those nets. This section begins with `$NETS`. 
Be sure to:

- Use the $A_PROPERTIES section when adding properties to the netlist.
- Include the line, $A_PROPERTIES, after you define all the parts in the $PACKAGES section when adding component or part-level properties to the netlist.
- Include the line, $A_PROPERTIES, after you define all the nets in the $NETS section when adding net or signal-level properties to the netlist.
- Use the $SCHEDULE section to define specific pin order connection. Include this section after the $NETS section. Figure 2-7 shows an example of a schedule describing a T connection.
Table 2-4 shows the maximum field width and allowable characters for each data field in an Allegro PCB Editor netlist.

Table 2-4 General Rules for Netlist

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Length</th>
<th>Acceptable Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>package name</td>
<td>27</td>
<td>A to z, 0 to 9, dash (-) and underscore (_)</td>
</tr>
<tr>
<td>device type</td>
<td>30</td>
<td>All except ! and '</td>
</tr>
<tr>
<td>function designator</td>
<td>30</td>
<td>All except ! and '</td>
</tr>
<tr>
<td>reference designator</td>
<td>30</td>
<td>All except ! and '</td>
</tr>
<tr>
<td>pin number</td>
<td>30</td>
<td>All except ! and '</td>
</tr>
<tr>
<td>pin name</td>
<td>30</td>
<td>All except ! and '</td>
</tr>
<tr>
<td>net name</td>
<td>31</td>
<td>All except ! and '</td>
</tr>
<tr>
<td>property value</td>
<td>79</td>
<td>All except ! and '</td>
</tr>
<tr>
<td>tolerance</td>
<td>79</td>
<td>All except ! and '</td>
</tr>
<tr>
<td>user part number</td>
<td>79</td>
<td>All except ! and '</td>
</tr>
</tbody>
</table>

Data fields are not case-sensitive in netlists. Other rules to remember when creating a netlist include:

- Do not exceed 78 characters on a line in a data record. Extend records by adding a comma after the last instance in a line. The comma acts as a continuation mark.
- Include comments in parentheses; they are ignored by the netin process. Do not include comments within a data field.
Device File

A device file (Figure 2-8) must exist for each different part type used in the netlist. The device file name must be the part type as it appears in the netlist with the extension .txt. Allegro PCB Editor determines the path used for locating the device files with the environment variable devpath, defined in the env file.

You can create a device file in symbol mode using the File – Create Device (create device) menu command.

Figure 2-8 Device File Example

You must use device files if you import third-party netlist data into the Allegro PCB Editor. The Allegro Design Entry HDL and Allegro Design Entry CIS schematic tools provide electrical component descriptions and connectivity data. Third-party netlists do not contain electrical component descriptions, and therefore require the use of device files. Similar to symbol files, which provide physical component descriptions, device files provide electrical descriptions. Where physical descriptions include pin spacing, body size, and padstack information, electrical descriptions define input and output pins, power pins, and gate assignments.

When creating device files:

- Use lowercase letters with a .txt extension for device file names. However, note that the contents of device files are not case-sensitive.
- Use parentheses to enclose comments.
Include these mandatory lines in the device file:

```
PACKAGE
PINCOUNT
```

For additional information, see the *Transferring Logic Design Data* user guide in your documentation set.

## Allegro PCB Editor Flow

The Allegro PCB Editor integrated suite of software tools for systems design helps you perform the major tasks of PCB and Single Chip Microprocessor (SCM)/ Multi-Chip Module (MCM) design, including:

- **Logic design import**
  
  Create a printed circuit board design based on data from a Allegro Design Entry HDL or Allegro Design Entry CISschematic, or a netlist from another Computer Aided Engineering (CAE) system. Then, backannotate from the design to the schematic. Update Allegro PCB Editor and APD designs by performing engineering change orders (ECOs).

- **Physical layout**
  
  Place design elements and route them, either manually or automatically with the Allegro PCB Router.

- **Design analysis**
  
  Perform design analysis with SigNoise and EMControl.

- **Manufacturing output**
  
  Generate silk screens and penplots, and create artwork and drill files.

*Figure 2-9* shows the functional relationship between Allegro PCB Editor and other Cadence or Electronic Design Automation (EDA) tools for logic design, physical layout activities, and design analysis.
Figure 2-9 defines the typical PCB design flow process using Allegro PCB Editor.

Figure 2-10 PCB Design Flow Using Cadence Tools
LIBRARY DEVELOPMENT
- Create custom pad shapes
- Define library padstacks
- Define unique packages
- Define mechanical elements

LOGIC DATA TRANSFER
- Create design database
- Associate schematic

LAYOUT PREPARATION
- Define design rules (properties and constraints)
- Define layers (cross section)
- Create mechanical elements (outline, keepins, keepouts)

DESIGN LAYOUT
- Placement (automatic/interactive)
- Routing (automatic/interactive)

DESIGN COMPLETION
- Rename reference designators
- Backannotate
- Add power and ground planes
- Run Design Rule Checking (DRC)

MANUFACTURING OUTPUT
- Generate pen plots
- Create artwork
- Generate numerical control output
- Generate reports

DESIGN ANALYSIS
- Signal integrity analysis
- EMI Compliance
Allegro PCB Editor Menus and Functions

Allegro PCB Editor menu bar (shown below) groups tasks within each menu.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Lets you open, save, and close existing files, create new files, import information such as logic, Gerber artwork files, DFX data, IDF data, and so on, export a variety of data, and run scripts.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Lets you manipulate objects in your design, such as moving, copying, rotating, and deleting objects.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Lets you zoom in and out of a design, create, change, or restore a color visibility view, and customize your work environment.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>Lets you add lines, circles, rectangles, filled rectangles (frectangles), arcs, and text to your design.</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Lets you display and control colors and visibility of classes and subclasses (for more information, see Lesson 4-6: Associating Design Objects with Classes and Subclasses on page 148), highlight and dehighlight elements, calculate capacitance between any two conductor elements, view properties, and display ratsnest lines in your design or remove them from your design.</td>
</tr>
<tr>
<td><strong>Setup</strong></td>
<td>Lets you set up drawing parameters, grids, subclasses, and layers; define vias, constraint sets, properties, and areas; define user preferences (variables), and open the Constraint Manager.</td>
</tr>
</tbody>
</table>
### Menu Name | Functions
---|---
**Shape** | Lets you perform a variety of shape tasks including adding multi-sided shapes, rectangles, or circles to your design, creating non-copper polygons or rectangles within a copper area, creating circles within etch shapes that are recognized as unfilled during penplotting and photoplotting, choosing pins or vias to create an unfilled clearance hold for static shapes, and converting groups of lines and arcs into shapes.

**Logic** | Lets you handle all electrical changes, scheduling nets, and changing nets.

**Place** | Lets you set up automatic placement controls and define automatic placement grids for placing components, symbols, and modules in a design. A module is a user-defined grouping of components and related etch and pins.

**Route** | Lets you route manually or automatically.

**Manufacture** | Lets you specify parameters for adding drafting items to the layout, set parameters for the NC drilling program, add test points to the design, and create a Bill of Materials (BOM).

**Note:** *Manufacture - Dimension/Draft* commands in the layout mode are available under the *Dimension* menu item in symbol mode.

**Tools** | Lets you create modules, modify both design and library padstacks, specify parameters for silkscreening, create reports, check the database, and update the Design Rule Checking (DRC) markers.

**Help** | Lets you access Allegro PCB Editor help system, user documentation, web resources, and information about the International Cadence Usergroup (ICU). See Lesson 1-4: Accessing the Help System on page 56.
Table 2-6  Special Menus

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Function</th>
<th>Used In...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Lets you add pins, connections, reference designators, part numbers, and so on.</td>
<td>Allegro PCB Editor – symbol mode</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Manufacture - Dimension/Draft commands in layout mode are available under the Dimension menu in symbol mode.</td>
<td></td>
</tr>
<tr>
<td>Analyze</td>
<td>Lets you manage setup and simulation; specify the device and interconnect libraries used by the simulator during signal analysis; assign models to devices, pins, and bondwires; and remove model assignments.</td>
<td>Allegro PCB Editor XL</td>
</tr>
</tbody>
</table>

Menu Items and Corresponding Commands

Allegro PCB Editor menu items have corresponding commands that you can enter at the command line. For example, choosing Route – Connect from the menu bar operates in the same way as if you typed the `add connect` command in the console window.

When you choose a menu item from the menu bar, the name of the corresponding command appears in the Status window (lower right corner). For more information, see Lesson 2-1: Identifying Parts of the User Interface on page 65.

The commands also appear in the journal (.jrl) file. The journal file is a session transcript of all the commands executed, and messages generated by Allegro PCB Editor.
Verb/Noun Command Structure

Allegro PCB Editor graphical user interface (GUI) adheres to most Microsoft Windows™ standards for pull-down menus, accelerator keys, mouse use, icons, and so on. Allegro PCB Editor differs from most Windows applications, however, in that it follows the verb/noun structure where you select the command–then–object method of command execution. In Allegro PCB Editor:

1. First choose a command.

2. Then choose the specified object.

For example, to delete an object, choose Edit – Delete from the menu bar or type delete at the console window prompt, then choose the object that you want to delete.

Sources of Information

Additionally, you can obtain information from the following:

- SourceLink
- Cadence Customer Response Center
- Education Services
- International Cadence Usergroup (ICU)

SourceLink

SourceLink is a Cadence web site that provides technical information. You need to register so that you can access SourceLink. Access to SourceLink is limited to customers with a current Cadence Maintenance agreement.

Using SourceLink, you can:

- Get information on current and upcoming releases.
- Read technical application notes.
- Download SKILL code written by application engineers and other customers.
Allegro PCB Editor Tutorial
About Allegro PCB Editor

- Create Service Requests directly with the Customer Response Center.
- Check the status of Service Requests and Product Change Requests (PCRs) (customers in North America only).

You can access SourceLink with your Web browser at sourcelink.cadence.com or by using the Allegro PCB Editor Help menu. See Lesson 1-4: Accessing the Help System on page 56.

Cadence Customer Response Center

Technical support is available for customers who have a maintenance agreement with Cadence. If you need to report a problem in the software or documentation, submit a request from your SourceLink account.

Education Services

Cadence offers many education services for customers including traditional classes and web-based training, and will customize training for specific needs. Visit this web site, www.cadence.com/education, for a description of classes and schedule.
Module 1: Getting Started with Allegro PCB Editor

This module comprises these lessons:

- **Lesson 1-1: Creating a Project Directory** on page 47
- **Lesson 1-2: Starting Up Allegro PCB Editor** on page 51
- **Lesson 1-3: Setting Your Working Directory and Opening a Design**
- **Lesson 1-4: Accessing the Help System** on page 56

**Completion Time**

It should take approximately 2 hours to complete the written lessons in this module.

**Lesson 1-1: Creating a Project Directory**

**Overview**

You can set up various acceptable directory structures to accommodate the Allegro PCB Editor projects. For example, if you are using Allegro Project Manager, the interface to the Cadence board design solution and library management, the tool automatically creates the directory structure shown in the project directory example below.
You can also create a directory organized by project type. The example below shows a simplified view where you store design information in your home directory. This example shows several project directories (for example, proj1 and proj2) and subdirectories under each project.
The symbols and devices directories beneath a project directory contain symbols and devices that are unique to that project. These subdirectories parallel the structure of the library directories supplied by Allegro PCB Editor in `<install_dir>/share/lib/pcb_lib`, where `install_dir` is the directory in which Allegro PCB Editor is installed. A project can also contain other subdirectories, such as temporary directories for routing tests that let you run batch routes without replacing log or design files. By default, Allegro PCB Editor searches for symbols using this structure.
In this lesson, you will learn how to create a project directory on Windows 2000/XP-Pro and UNIX. For specific commands, see the Help available for your operating system.

Procedure

1. Create a directory called `proj2`.
   
   Use this location to save board files, log files, and reports when you work on your project.

2. Copy the board file, `cds_routed.brd`, `cds_routed_DRC.brd`, and the `colors.il` file from `<installation_directory>\doc\algrotutorial\examples` to the `proj2` directory.
   
   You will use this directory when working on the lessons in this tutorial.

3. Create a `devices` subdirectory in the `proj2` directory.
   
   Use this location to store device files when you work on your project.

4. Create a `symbols` subdirectory in the `proj2` directory.
Use this location to store symbols when you work on your project.

Summary

You now know that there are different methods for setting up a project directory. You also know how to set up a sample project directory.

You have learned the following:

- **Another Cadence product**: Allegro Project Manager
- **Library directory pathname**: `<install_dir>/share/lib/pcb_lib`

For More Information

See “Introduction to Project Manager” in the *Project Manager User Guide*.

What’s Next

Go to Lesson 1-2: Starting Up Allegro PCB Editor to learn how to start up the Allegro PCB Editor.

Lesson 1-2: Starting Up Allegro PCB Editor

Overview

If you purchased more than one type of Allegro PCB Editor tool, when you invoke Allegro PCB Editor, you must choose which license to use from the product suite. For additional information on product choices, see *Allegro PCB Editor Tools* on page 21.

In this lesson, you will learn how to start up Allegro PCB Editor on Windows or UNIX.
Procedure

1. Start up Allegro PCB Editor in one of the following ways, depending on whether you are working on Windows or UNIX:

   a. On Windows, use one of the following methods to start the editor:

      ○ Click the Windows Start button (bottom left of your screen) and choose Programs – Cadence SPB ** - ** where** - ** represents the name you assigned to Allegro PCB Editor application.

      ○ Double click the Allegro PCB Editor icon.

      ○ Double click a .brd file.

         If you choose this method, be sure that you have associated the Allegro PCB Editor executable with the .brd file type.

      ○ Open the Allegro Project Manager, your project, and then click Layout.

   b. On UNIX, use one of the following methods:

      ○ At the shell prompt, type:

         allegro &

      ○ At the shell prompt, type:

         allegro

      ○ Open the Allegro Project Manager, your project, and then click Layout.

   The About <product name> splash screen briefly appears.

   If you type allegro &, it means that Allegro PCB Editor is running in the background. When you use this startup method, you may not see all messages displayed in the window.

   The first time you launch Allegro PCB Editor, the Cadence Product Choices dialog box appears. If you do not enable the Use As Default option, the Cadence Product Choices dialog box appears each time you use Allegro PCB Editor.
If you enable the *Use As Default* option, the Cadence Product Choices dialog box no longer appears when you start up. However, you can still change the license. See step 10 of the *Procedure* on page 72 in *Lesson 2-1: Identifying Parts of the User Interface* for additional information.

2. Choose *Allegro PCB Design XL*, check the *Use As Default* box, and click *OK*.

This sets the Allegro PCB Design XL version as your default. This version is used for the exercises in this tutorial. If you are not licensed for this version, choose the version for which you have a license. Tasks that specifically require Allegro PCB Design XL features will be noted.

Allegro PCB Editor with the layout command menu set appears.

**Note:** If you are running a release later than Release 15.0, the Allegro PCB Editor has additional features. See *Lesson 2-1: Identifying Parts of the User Interface* on page 65

**Summary**

You now know how to start up the Allegro PCB Editor.

You have learned the following:

- **New command:** `allegro &`
- **New window and dialog box:** Allegro PCB Editor Cadence Product Choices dialog box

**For More Information**

See the *Getting Started with Physical Design* user guide in your documentation set

**What’s Next**

Go to *Lesson 1-3: Setting Your Working Directory and Opening a Design* to learn how to set up your working directory and open a design.
Lesson 1-3: Setting Your Working Directory and Opening a Design

Overview

The first time you start Allegro PCB Editor, the current directory is set to a location specified during the software installation. This directory name appears in the title bar of Allegro PCB Editor. All files that are created or saved from within Allegro PCB Editor are saved to the current directory by default. When you open or save files, you can change the current directory to a directory where you want to save your work.

Demo

Setting Your Working Directory and Opening a Design

This demonstration runs for approximately 1 minute.

Procedure

1. From the menu bar, choose File – Open.

An Open file browser window appears.

In Module 2, you will learn to use console window commands and toolbar icons as an alternative to menu commands.

2. Using the directory structure you established in Lesson 1-1: Creating a Project Directory on page 47, navigate to the proj2 directory.
3. **Verify that the Change Directory box is checked.**

This option sets your working directory to `proj2`.

**Note:** The two buttons below the Help button are preview buttons available only in releases later than Release 15.0. When pressed, the left button provides a text preview and the right button provides a graphics preview of the selected design.

4. **Choose the cds_routed.brd file and click Open.**

The `cds_routed.brd` file appears in Allegro PCB Editor.

**Note:** You can also open a file by double clicking it if you have associated Allegro PCB Editor with the `.brd` file type.

**Summary**

You now know how to set a working directory and open a board design.

You have learned the following:
For More Information

See the *Getting Started with Physical Design* user guide in your documentation set.

What’s Next

Go to Lesson 1-4: Accessing the Help System to learn how to get help for Allegro PCB Editor.

Lesson 1-4: Accessing the Help System

Overview

You can get help in using Allegro PCB Editor with the following methods:

- Help Menu on the Allegro PCB Editor menu bar – When you select *Help – Documentation*, a Help page interface displays all product documentation in tabbed categories so that you can get the information you are looking for quickly. You can also access web resources, including SourceLink—the Cadence Online Customer Support—Frequently Asked Questions, and the web site for Cadence Education Services. For additional information, see *Sources of Information* on page 44.

  - Documentation tab lists user guide and reference information for key concepts and comprehensive point-of-need information. The Help page opens to this tab by default.

  - Release Info tab lists release-specific information such as What’s New, migration documentation, system requirements, and so on.

  - Best Practices tab lists Cadence-recommended practices for key product features and tools.
Allegro PCB Editor Tutorial
Module 1: Getting Started with Allegro PCB Editor

- Tutorials tab lists self-paced training lessons in a step-by-step format that teach you how to use the product.

- Demos tab lists flash-based multimedia videos so that you can watch an example of how to use certain features or processes. Products with many demonstrations may have sub-categories from which to choose on the left-hand side of the Demos tab.

**Note:** To view multimedia demonstrations, you need a compatible Flash player. For more information about Flash players that you can download without cost, see [http://www.macromedia/shockwave/](http://www.macromedia/shockwave/).

- Command Browser – A browser that lists all the editor commands and lets you run the command or obtain help on the command.

- Console window help – Part of Allegro PCB Editor that lets you enter help and the command name at the command prompt.

- F1 help – Help available when you highlight a menu item or toolbar icon and press the F1 function key.

**Note:** In versions later than Release 15.1, you can also press the F1 key during an active command to get help.

### Demo

You can take a guided multimedia tour that demonstrates the user documentation that accompanies your installation of Allegro platform products.

[Discovering Allegro Platform Documentation](#).

This demonstration runs for approximately 5 minutes.

### Procedure

#### Using the Help Menu

1. From the Allegro PCB Editor menu bar, choose *Help* to display the menu options.
2. From the menu items, choose Documentation. The Documentation tab appears that lists user guide and reference information for key concepts and comprehensive point-of-need information. The Help page opens to this tab by default.

You can also type cdsdoc at the console window prompt to display the Allegro PCB and Package Physical Layout Command Reference.

This message appears in the console window:

cdsdoc is starting, please wait...

3. Scroll down to the bottom of the main page to view the list of documents that make up the Allegro PCB and Package Physical Layout Command Reference.

4. Click A to open the Table of Contents for the document of commands beginning with the letter A.

5. Scroll down to the add connect command and click on it to display the information related to this command. Based on the length of the description for the command, hot links to the various sections of the help appear under the command name.

6. Scroll to the top of this page and view the document menu bar, shown below.

7. From the document menu bar, you can:

   - Open the library of all SPB documents and search these documents.
   - Display the Table of Contents for the current document.
   - Display the Index (if available) for the current document.
   - View the previous or next chapter in a book.
   - View, print, or save to disk the PDF version of the document.
Allegro PCB Editor Tutorial
Module 1: Getting Started with Allegro PCB Editor

- Search for words and phrases in the library or in a subset of documents.
- Provide feedback on the documentation.
- Get help on using the Help system.
- Exit the Help system.

8. Click Library from the document menu bar to open the CDSDoc: Library window. You can review and search the documents that are categorized by product.

9. From the menu bar of the CDSDoc: Library window, choose File – Close to close the window.

10. Choose View/Print PDF from the document menu bar to open the PDF version of the Allegro PCB and Package Physical Layout Command Reference: A Book.

   You can review, search, or print the document. You can also save the PDF version to disk for later review.

11. Choose the Release Info tab and choose What’s New to display the current product release notes.

   You can review, search, or print the document.

12. Choose the Allegro Platform Migration Guide to display information about changes from release to release of software.

   You can review, search, or print the document.

13. From the Allegro PCB Editor menu bar, choose Help – Web Resources – SourceLink to open SourceLink, the online Customer Support Center web site.

   For additional information about SourceLink, see SourceLink on page 44.


Demo

Using the Command Browser to Access Help

This demonstration runs for approximately 1 minute.
Procedure

Using the Command Browser to Access Help

1. At the console window prompt located at the bottom of Allegro PCB Editor (Command>), type `helpcmd` to display the Command Browser.

   **Note:** If you are running a release later than Release 15.0, you can also choose *Tools – Utilities – Keyboard Commands* from the menu bar. For additional information, see Lesson 2-1: Identifying Parts of the User Interface on page 65.

   If you click *Execute* (default) in the Command Browser, and then choose a command, Allegro PCB Editor activates the command. If you click *Help*, and then choose a command, Allegro PCB Editor displays help for the command. If you inadvertently execute a command, click the right mouse button in Allegro PCB Editor, and choose *Cancel* from the pop-up menu.
2. In the Command Browser, click Help and then click on a command name, for example, add arc, to display documentation for the add arc command.

3. To limit the display of command selections:
   
a. Type a command name or enter a partial string with wildcards, for example, type ?ol* in the Filter text box.

   ? is the wildcard for any single character and * for multiple characters.

   b. Press the Tab key.

   The result is the following display of commands:
Demo

Using Other Methods to Access Help

This demonstration runs for approximately 1 minute.

Procedure

Using Other Methods to Access Help

You can access help for a particular command or function using various methods including the console window, F1 function key, and dialog boxes. In this procedure, you will learn how to access help for the File – Export – Logic (feedback command) menu option. Information on the menu bar and the console window commands is available in “Lesson 2-1: Identifying Parts of the User Interface” on page 65.

1. In the Allegro PCB Editor, type the following at the console window prompt:
   
   Command> help feedback

   The help documentation for the feedback command appears in the web browser.

2. Close the web browser.

3. From the Allegro PCB Editor menu bar, simultaneously, highlight File – Export – Logic and press the F1 function key.

   The help documentation for the feedback command appears again.

4. Close the web browser.
5. From the Allegro PCB Editor menu bar, choose File – Export – Logic.

The Export Logic dialog box appears.

6. Click Help in the dialog box to display the help documentation for the feedback command.

7. Close the Export Logic dialog box.

8. Close the web browser.

Summary

You now know how to access help using the Help menu, Command Browser, console window, F1 function key, and dialog boxes.


- **New console commands**: cdsdoc, helpcmd, help feedback, add arc, color

- **New function key commands**: F1

- **New window and dialog box**: CDSDoc: Library window, Export Logic dialog box

- **New documents**: Allegro PCB Design Editor: What’s New, Migration Guide for Allegro Platform Products, Allegro PCB and Package Physical Layout Command Reference

What’s Next

Go to Module 2: Introducing the Allegro PCB Editor User Interface to learn about the various components of the Allegro PCB Editor user interface.
Module 2: Introducing the Allegro PCB Editor User Interface

This module comprises these lessons:

- Lesson 2-1: Identifying Parts of the User Interface on page 65
- Lesson 2-2: Accessing Pop-up Menus and Panning a Design on page 75
- Lesson 2-3: Zooming In and Out of a Design on page 78
- Lesson 2-4: Using Other Methods to Zoom In and Out of a Design on page 81

Completion Time

It should take approximately 90 minutes to complete the written lessons in this module.

Lesson 2-1: Identifying Parts of the User Interface

Overview

Allegro PCB Editor appears when you start up the software. The modes (Layout, Symbol) available to you depend on the task you are performing and the Allegro PCB Editor product you are running.

The following example shows Allegro PCB Editor in layout mode.
The following list describes the components of Allegro PCB Editor:

- **Menu bar** – Located below the title bar is the menu set. Allegro PCB Editor has two menu sets: Layout mode, used for general design work, and Symbol mode, used for the creation and modification of symbols. These menu sets differ, based on the product in which you are working. The pull-down menus contain all the commands required to create and modify a design.

You can also use the accelerator key combinations to execute some commands. The key combinations appear in the pull-down menus, to the right of the command. For example, to open a file, choose **File – Open** from the menu bar or press **Ctrl+O**.
As an alternative to using the menu items, you can use console commands. You can see the corresponding console command displayed in the Status window when you choose a menu item. For example, when you choose the menu item *File – Open*, the corresponding console command, `open`, appears in the Status window. See the descriptions of Console window and Status window in the following sections.

- **Icon toolbar** – Located below the menu bar, the toolbar contains icons that give you a quick way to access common Allegro PCB Editor commands. The labels indicate groups of icons (toolset) that correspond to functions you can perform using the menu or submenu names. For example, the second icon in the File toolset corresponds to the *File – Open* menu item.

- **Design window** – Located below the icon toolbars, the Design window is the graphical display area where you do most of your design work. You can change the default background color of the Design window. See *Lesson 3-4: Controlling Colors and Dimming Graphics* on page 99.

- **Console window** – Located at the bottom left portion of the Allegro PCB Editor, this window has two functions. It displays messages, and prompts you when you choose menu items to perform tasks. In this window, you can also type Allegro PCB...
Editor console commands at the prompt as an alternative to using the menus.

- **Status window** – Located to the right of the Console window, the Status window contains the current command being executed. In this case, the word *Idle* appears because no command is currently active. It also shows the current x, y coordinates of the cross hairs. These coordinates change as you move the mouse.

  **Note:** If you are running a release later than Release 15.0, you can access the *P* and *A* buttons in the Status window.

  The *P* button allows you to display a dialog box. When you click this button, and you are in an interactive command, for example, *add connect*, the Pick dialog box appears and remains displayed until you dismiss it. If the *Cmd* status is *Idle*, and you click the *P* button, the Zoom Center dialog box appears and remains displayed until you dismiss it. You can enter specific or incremental values in these dialog boxes.

  The *A* button allows toggling of the x, y read-out from absolute mode to relative mode. When you are in absolute mode, the x, y coordinates location is from the origin of the board. When you are in relative mode, the origin is always from the last pick and the button is labelled *R*. Allegro PCB Editor always starts designs in absolute mode.

  The Status window has a *Stop* button, which you can use to interrupt the current command. The *Stop* button is presently unavailable because there is no command currently active.

  In the Status window, the *Cmd* box is colored green, yellow, or red and acts like a traffic light. If the box is green, it means that Allegro PCB Editor is ready for your command. If the box is yellow, it means that the system is working—but you can interrupt the system by clicking the *Stop* button, pressing `Ctrl-C`, or pressing the *Esc* key. If the box is red, the system is working and you are unable to interrupt it. You must wait until the box turns either yellow or green again.

- **Control Panel** – The area to the right of the Design window contains the Control Panel (shown below) and the World View window.
The Control Panel has three tabs:

- The Options tab contains parameters used to control the current interactive command.

- The Find tab, sometimes referred to as the Find Filter, lets you select the objects that will be affected by the active command. You can use this tab when selecting items with the mouse or when selecting items using the Find By Name box.

Basic building blocks for use in board design, also listed in the Find tab, are described below.

<table>
<thead>
<tr>
<th>Design Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groups</td>
<td>One or more objects linked together so that you can easily perform commands on them.</td>
</tr>
</tbody>
</table>
### Design Object Description

<table>
<thead>
<tr>
<th>Design Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comps</td>
<td>The combination of a symbol and logical description of a part.</td>
</tr>
<tr>
<td>Symbols</td>
<td>The physical description of a part, such as pins, part outline, and so on.</td>
</tr>
<tr>
<td>Functions</td>
<td>A logical unit of an electronic part such as an integrated circuit, also referred to as a gate.</td>
</tr>
<tr>
<td>Nets</td>
<td>The signal name associated with a component pin.</td>
</tr>
<tr>
<td>Pins</td>
<td>Numbered electrical connection points (pads) on a symbol or component. Non-electrical pins on mechanical symbols or components do not have pin numbers.</td>
</tr>
<tr>
<td>Vias</td>
<td>The physical mechanism to traverse layers when connecting a net.</td>
</tr>
<tr>
<td>Connect LInes, (Clines)</td>
<td>A conductor trace associated with a net name. It begins and ends on a pin, via, or Tpoint.</td>
</tr>
<tr>
<td>Lines</td>
<td>A graphical line.</td>
</tr>
<tr>
<td>Shapes</td>
<td>A closed polygon. This shape may be used to represent internal power planes, keepout areas, keepin areas, and so on.</td>
</tr>
<tr>
<td>Voids</td>
<td>Non-copper polygon or circle within an etch layer shape.</td>
</tr>
<tr>
<td>Cline Segs</td>
<td>A portion of a cline. The segment is from one vertex (bend) point to the next vertex point (<em>Route – Connect</em> command).</td>
</tr>
<tr>
<td>Other Segs</td>
<td>Non-cline such as an arc, circle, and line (<em>Add</em> menu).</td>
</tr>
</tbody>
</table>
The Visibility tab lets you control the visibility of conductor objects in your design such as etch, pins, vias and so on.

For information on using the Control Panel, see Lesson 3-3: Controlling Etch Visibility on page 97 and Lesson 3-5: Using the Control Panel to Manipulate Design Objects on page 103. For information on customizing the Control Panel, see Lesson 5-1: Customizing Your View and Toolset on page 159.

The World View window is located below the Control Panel. It shows the board outline and the portion of the board where you are currently zoomed in. It gives you quick and convenient access to the panning and zooming commands. For additional
information on zooming and panning, see Lesson 2-2: Accessing Pop-up Menus and Panning a Design on page 75.

In this lesson, you will perform tasks to become familiar with the Allegro PCB Editor user interface.

Demo

Identifying Parts of the User Interface

This demonstration runs for approximately 7 1/2 minutes.

Procedure

1. If it is not already displayed in Allegro PCB Editor, open cds_routed.brd.

   Note: If you are running a release later than Release 15.0 and you previously opened this board file, you can also choose File – Recent Designs from the menu bar and choose the board file.
2. Maximize the editor to full screen mode, if it is not already maximized.

3. Referring to the information in the section, Overview on page 65, identify the following parts of the editor:
   - Menu bar and menu items
   - Icon toolbar
   - Design window
   - Console window (and command line)
   - Status window with its traffic light and coordinate readouts
   - Control Panel: Options, Find, and Visibility tabs
   - World View window

4. View the menu options. Choose the File menu and note the available menu items. Slowly pass your cursor over the menus (Edit, View, Add and so on) from left to right. Note the various menu items available under each menu. For additional information on these menus, see Allegro PCB Editor Menus and Functions on page 41.

5. Click the left mouse button in the Design window to close your latest pull-down menu.

6. Slowly drag (do not click) your cursor across the toolbar from left to right and read the tool tips that appear.

   You can customize icon displays to suit specific needs. For additional information, see Lesson 5-1: Customizing Your View and Toolset on page 159.

7. When you come to the Zoom Fit (F9) icon, click it.

   The entire cds_routed.brd design is framed in the Design window.

8. Choose menu items to run commands, while viewing the corresponding console command name in the Status window. Click the right mouse button in the Design window and click Cancel on the pop-up menu to inactivate a command.

9. Find commands that cause the status to be red. Then find commands that cause the status to be yellow.
10. Use one of these commands to change editors:

- From the menu bar, choose *File – Change Editor.*
- At the console window prompt, type `toolswap`.

The Cadence Product Choices dialog box appears.

11. Choose one of the options and click *OK.*

The editor changes.

12. Use one of these commands to change back to the previous editor:

- From the menu bar, choose *File – Change Editor.*
- At the console window prompt, type `toolswap`.

13. Use one of these commands to exit Allegro PCB Editor:

- From the menu bar, choose *File – Exit.*
- At the console window prompt, type `exit`.

**Summary**

You now can identify the different parts of Allegro PCB Editor user interface and are familiar with Allegro PCB Editor menus and menu items.

You have learned the following:

- **New terms:** absolute mode, relative mode
- **New menu commands:** *Route – Connect, File – Open, View – Customization – Toolbar, File – Change Editor, File – Exit*
- **New console commands:** `toolswap`, `add connect`, `exit`
- **New toolbar icon:**
- **New function key commands:** F6, F9
- **Parts of the user interface:** Layout mode, Symbol mode, menu bar, icon toolbar, Design window, Console window, Status window, Control Panel, *Options* tab, *Find* tab (Find Filter),
Visibility tab, World View window, Placement toolbar, Route toolbar, Analysis toolbar, Manufacturing toolbar

For More Information

See
- the *Getting Started with Physical Design* user guide in your documentation set.
- Pick dialog box in the *Allegro PCB and Package Physical Layout Command Reference*.
- `toolswap` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- `add connect` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- `exit` command in the *Allegro PCB and Package Physical Layout Command Reference*.

What’s Next

Go to Lesson 2-2: Accessing Pop-up Menus and Panning a Design to learn how to access pop-up menus and pan a design.

Lesson 2-2: Accessing Pop-up Menus and Panning a Design

Overview

Allegro PCB Editor supports panning, or roaming a design, which is the action of moving across a design in the editor window. You can pan a design using a mouse device or arrow keys on the keyboard.

Allegro PCB Editor supports all mouse devices that have at least two buttons and are supported by your workstation. For additional information on mouse devices and panning, see the *Getting Started with Physical Design* user guide in your documentation set.
In this lesson, you will learn how to access pop-up menus and pan a design.

**Demo**

*Accessing Pop-up Menus and Panning a Design*

This demonstration runs for approximately 2 1/2 minutes.

**Procedure**

1. Start Allegro PCB Editor. If necessary, see Lesson 1-2: Starting Up Allegro PCB Editor on page 51.

2. Open cds_routed.brd.

3. Use one of these commands to activate the *slide* command:
   - From the menu bar, using the left mouse button, choose *Route – Slide*.
   - At the console window prompt, type *slide*.
   - Click .
   - Press SF6 (Shift + F6 function key).

   Notice that the *slide* command is listed in the Status window.

4. Move your cursor into the editor window and click the right mouse button.

   A pop-up menu appears. The contents of the pop-up menu varies with the menu item or command you are using. For example, this pop-up menu is different from the pop-up menu displayed when you choose *Route – Connect* (add connect command).

5. Choose *Cancel* from the pop-up menu to exit the *Route – Slide* function. You can also press the F4 function key.

6. Use one of these commands to activate the *add connect* command:
   - From the menu bar, choose *Route – Connect*.
   - At the console window prompt, type *add connect*.
Allegro PCB Editor Tutorial
Module 2: Introducing the Allegro PCB Editor User Interface

❑ Click .
❑ Press F6.

7. Move your cursor into the editor window, click the right mouse button, and examine the pop-up menu.

8. Choose Cancel from the pop-up menu to exit the Route – Connect command, or press the F4 function key.

9. Place the cursor in the editor window. Press and hold the middle mouse button down and slide the mouse to the left, right, up, and down.

   If you have a two-button mouse, you can press and hold the Shift key while you hold the right mouse button down and slide the mouse.

   Notice how the design shifts in the direction of your cursor movement. This is panning. Also notice how the view changes in the World View window, located at the bottom right of the editor.

10. Use the arrow keys on your keyboard to pan the design.

11. To control the amount of movement when panning using the arrow keys:


   b. Click Roam in the Categories section.

   c. Set a value for the roaminc environment variable and click OK.

      The default value is 96.

   See Lesson 5-3: Setting Environment Variables on page 167 for additional information.

Summary

You now know how to access pop-up menus when you are in command mode, and pan a design.

You have learned the following:

- **New term**: panning
New menu commands: Route – Slide, Setup – User Preferences

New console commands: slide, add connect, enved

New toolbar icons: 

New function key commands: F4, SF6

New environment variable: roaminc

For More Information

See the Getting Started with Physical Design user guide in your documentation set.

What’s Next

Go to Lesson 2-3: Zooming In and Out of a Design.

Lesson 2-3: Zooming In and Out of a Design

Overview

Allegro PCB Editor supports zooming in and out of a design. You can zoom using a mouse device, menu items, console commands, icons, function keys, or the World View window.

In this lesson, you will learn how to zoom in and out of a design using the middle mouse button on your mouse device.

Note: The steps in this procedure involve a three-button mouse. If you have a mouse with programmable keys, for example, a two-button wheel mouse, the mouse behavior may be different based on your settings. See the Getting Started with Physical Design user guide in your documentation set.

Demo

Zooming In and Out of a Design
This demonstration runs for approximately 1 1/2 minutes.

Procedure

1. If it is not already displayed in the editor window, open cds_routed.brd.

2. Place the cursor in the bottom right portion of the Design window. Press but do not hold the middle mouse button in the window.

   If you have a two-button mouse, press the Shift key while you select with the right mouse button.

3. Move your cursor toward the top left portion of the window.

   Notice as you move your cursor that a rectangle is drawn. This represents what will be the new display area.

4. Select again with the middle mouse button or the left mouse button.

   The area that was contained within the white rectangle now becomes your new display area.

5. Select again with the middle mouse button somewhere in the middle of the display area. Do not hold down the middle mouse button.

6. Move your cursor slowly toward the bottom right.

   As you move your cursor, two white rectangles are drawn. The inside rectangle represents the original display area. The outside rectangle represents a zoom-out magnification. The further the outside rectangle is away from the inside rectangle, the greater the zoom-out. As you move your mouse, you see your work area temporarily refresh. This temporary redisplay represents what will be the new work area.
7. Select again with the middle mouse button or the left mouse button.

The board in the window is redrawn to match the current zoom.

**Note:** To disable the dynamic zoom feature, set the `no_dynamic_zoom` environment variable in the *Display* category of the User Preferences Editor. By setting this variable, middle-button functionality is limited to zooming in or zooming out. See Lesson 5-3: Setting Environment Variables on page 167 for additional information.

**Summary**

You now know how to zoom in and out of a design using the middle mouse button on your mouse device, and how to disable the dynamic zoom feature.

You have learned the following:

- **New term:** zooming
- **New environment variable:** `no_dynamic_zoom`

**For More Information**

See the *Getting Started with Physical Design* user guide in your documentation set.

**What’s Next**

Go to Lesson 2-4: Using Other Methods to Zoom In and Out of a Design to learn the various methods for zooming in and out of a design.
Lesson 2-4: Using Other Methods to Zoom In and Out of a Design

Overview

In addition to using a mouse for zooming in and out of a design, you can also use other methods. In this lesson, you will use menu items, toolbar icons, console commands, and function keys to zoom in and out of a design.

Demo

Using Other Methods to Zoom In and Out of a Design

This demonstration runs for approximately 2 minutes.

Procedure

1. If it is not already displayed in the window, open cds_routed.brd.

2. Use one of these commands to specify a new display area by picking two diagonally opposed points:
   - From the menu bar, choose View – Zoom By Points.
   - At the console window prompt, type zoom points.
   - Click.
   - Press F8.

   Notice that the zoom points command is listed in the Status window. In the Console window, you are prompted to pick the first corner of a new view window.

3. Click to place the first corner of the new window.

   As you move your cursor, a rectangle with inscribed diagonals representing the new window forms.

4. Click again to fix the size of the new window.
The window zooms to display only the area you just outlined within the rectangle.

5. Use one of these commands to display the entire extents of the drawing in the window:
   - From the menu bar, choose View – Zoom World.
   - At the console window prompt, type `zoom world`.

6. Use one of these commands to create a view that includes but is no larger than the board:
   - From the menu bar, choose View – Zoom Fit.
   - At the console window prompt, type `zoom fit`.
   - Click on the magnifying glass icon.
   - Press F9.

7. Use one of these commands to magnify or zoom into a smaller area of the drawing that remains centered about the same point:
   - From the menu bar, choose View – Zoom In.
   - At the console window prompt, type `zoom in`.
   - Click on the magnifying glass icon.
   - Press F10.

8. Use one of these commands to increase the displayed area of the drawing.
   - From the menu bar, choose View – Zoom Out.
   - At the console window prompt, type `zoom out`.
   - Click on the magnifying glass icon.
   - Press F11.

   This shows more data in the window and makes objects become smaller.

9. Use one of these commands to fit the design in the window:
   - From the menu bar, choose View – Zoom Fit.
   - At the console window prompt, type `zoom fit`. 
Allegro PCB Editor Tutorial
Module 2: Introducing the Allegro PCB Editor User Interface

- Click .
- Press F9.

Summary

You now know how to zoom in and out of a design using menu items, toolbar icons, console commands, and function keys.

You have learned the following:

- **New menu commands**: View – Zoom By Points, View – Zoom World, View – Zoom Fit, View – Zoom In, View – Zoom Out
- **New console commands**: zoom points, zoom world, zoom fit, zoom in, zoom out
- **New toolbar icons**:
- **New function key commands**: F8, F9, F10, F11

For More Information

See:

- the *Getting Started with Physical Design* user guide in your documentation set.
- **zoom points** command in the *Allegro PCB and Package Physical Layout Command Reference*.
- **zoom world** command in the *Allegro PCB and Package Physical Layout Command Reference*.
- **zoom fit** command in the *Allegro PCB and Package Physical Layout Command Reference*.
- **zoom in** command in the *Allegro PCB and Package Physical Layout Command Reference*.
- **zoom out** command in the *Allegro PCB and Package Physical Layout Command Reference*. 
What’s Next

Go to Module 3: Using Allegro PCB Editor Control Functions to learn some control functions for Allegro PCB Editor.
Module 3: Using Allegro PCB Editor Control Functions

This module comprises these lessons:

- Lesson 3-1: Changing the Cursor Display on page 85
- Lesson 3-2: Controlling Color and Visibility on page 89
- Lesson 3-3: Controlling Etch Visibility on page 97
- Lesson 3-4: Controlling Colors and Dimming Graphics on page 99
- Lesson 3-5: Using the Control Panel to Manipulate Design Objects on page 103
- Lesson 3-6: Highlighting Objects on page 113
- Lesson 3-7: Listing Detailed Information About a Specified Object on page 116
- Lesson 3-8: Measuring Distance Between Objects on page 120

Completion Time

It should take approximately 150 minutes to complete the written lessons in this module.

Lesson 3-1: Changing the Cursor Display

Overview

By default, Allegro PCB Editor sets the cursor to cross hair. In this lesson, you will change the cursor to infinite so that you can better line up components in a design.
Demo

Changing the Cursor Display

This demonstration runs for approximately 1 1/2 minutes.

Procedure

1. If it is not already displayed in Allegro PCB Editor, open `cds_routed.brd`.

2. Use one of these commands to display the User Preferences Editor:
   - From the menu bar, choose **Setup – User Preferences**.
   - At the console window prompt, type `enved`. 
3. Click **UI** in the **Categories** section.

4. In the **Value** column, click the drop-down list next to the **pcb_cursor** preference and choose **infinite**.

   The **Effective** field states that this change takes effect immediately. The **Summary description** field at the bottom left corner displays a short description of the action that occurs when you click a check box or place the cursor in a text box.

5. Click **OK** to save the change and close the dialog box.
The cursor changes to infinite and now spans the height and width of your window. The change you made is stored in the `env` file located in the `pcbenv` directory in your home directory. This setting is used each time you start up Allegro PCB Editor. For additional information on setting preferences, see Lesson 5-3: Setting Environment Variables on page 167.

6. Reverse your choices to change the cursor back to a cross hair.

### Summary

You are now able to modify the cursor display.

You have learned the following:

- **New terms:** cross hair, infinite
- **New menu bar command:** Setup – User Preferences
- **New console command:** `enved`
- **New dialog box:** User Preferences Editor

### For More Information

See:

- `enved` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- *env File*.

### What’s Next

Go to Lesson 3-2: Controlling Color and Visibility to learn about classes and subclasses, and how to turn on the visibility of classes and subclasses, apply colors to subclasses, customize colors, and save color settings.
Lesson 3-2: Controlling Color and Visibility

Overview

Design objects are categorized by class and subclass. Classes are major categories defining the purpose of the design objects. Subclasses further define the purpose of the design objects. You can control how each class and subclass appears in the Design window. You can determine which colors to use for the subclasses.

The Color and Visibility dialog box organizes classes and subclasses into groups to make it easier to view design objects. This dialog box lets you view and edit the visibility of objects based on class and subclass. Allegro PCB Editor supports 24 color definitions, and numbers them 1-24. When you start a new design, the default setting is to have every class and subclass visible with default color assignments.
In the next three procedures, you will learn how to perform these tasks:

- **Applying Colors to Classes and Subclasses**
- **Customizing Colors**
- **Modifying and Saving the Color Palette**

**Demo**

**Applying Colors to Classes and Subclasses**

This demonstration runs for approximately 5 minutes.
Procedure

Applying Colors to Classes and Subclasses

1. From the menu bar, choose File – Save As to save the cds_routed.brd file as cds_routed1.brd.

2. With cds_routed1.brd displayed in the Design window, use one of these commands to display the Color and Visibility dialog box:
   - From the menu bar, choose Display – Color/Visibility.
   - At the console window prompt, type color.
   - At the icon toolbar, click .

3. At the top right of the Color and Visibility dialog box, click on the Global Visibility drop-down list and choose All Invisible.

   When the Global Visibility dialog box appears, click Yes to change all classes and subclasses to invisible. Notice that the check marks are removed from the visibility boxes. This action resets all the colors to off, so you can begin setting them to the colors you want.

4. Click Apply.

5. From the Group drop-down list, choose Components.

   The list shows all the groups that contain all the classes and subclasses in Allegro PCB Editor including:
   - Geometry
   - Manufacturing
   - Stack-Up
   - Components
   - Areas
   - Analysis

   Notice that the class names for the Components group are listed horizontally near the top of the dialog box, and the subclass names are listed vertically at the left side of the dialog.
box. Each class also has an All check box. If checked, it automatically checks all the subclasses within the class. Each subclass has a visibility check box and a color push button.

6. Under the Ref Des class, check the visibility box for the subclass Assembly_Top.

A check mark in the box indicates that the visibility for that subclass is turned on.

7. From the Group drop-down list, choose Geometry.

The Geometry classes are Board Geometry and Package Geometry.

8. Under the Board Geometry class, check the visibility box for the Outline subclass.

9. Under the Package Geometry class, check the visibility box for the Assembly_Top subclass.

10. From the Group drop-down list, choose Stack-Up.

11. Check the visibility boxes or subclasses in this group, as shown in the Color and Visibility dialog box below, then click Apply.
12. Click the Number 13 button in the *Palette* section of the Color and Visibility dialog box (see *Overview* on page 89 for information on the numbers).

The color is displayed in the square box to the left of the *Modify* button.

13. Click the color push buttons next to the *Bottom* subclass for *Pin*, *Via*, and *Etch* classes to change the color to the color displayed in the *Modify* box (Number 13 block in the Palette).

14. Click *Apply* to save the class/subclass settings.

**Demo**

Customizing Colors

This demonstration runs for approximately 2 minutes.

**Procedure**

**Customizing Colors**

Allegro PCB Editor provides a global palette that is used initially for all designs. You can apply the global palette, which supports up to 24 color definitions, to any design. In the palette, each block is associated with a color. You can customize colors for your use.

To customize a color:

1. With *cds_routed1.brd* displayed in the Design window, click the number 13 color box (used in the previous lesson) in the *Palette* section of the Color and Visibility dialog box and then click *Modify*.

The Color Editor dialog box appears.
2. Adjust the color setting by doing one of the following:

Enter numerical values in the color setting text boxes to create a dark blue color

or

a. Keeping the left mouse button pressed, move the cursor around the color selection chart.

b. Release the mouse button when the color in the Color viewer appears dark blue.

c. Adjust the luminosity setting in the text box or on the slide bar.

3. Click OK in the Color Editor dialog box to save the color and dismiss the dialog box.

In your design, the objects that used the color previously displayed in the Number 13 block, now change to blue.

4. Click Apply and OK in the Color and Visibility dialog box.
Once you save a design, the color settings and palette are saved with the design file.

Demo

Modifying and Saving the Color Palette

This demonstration runs for approximately 2 minutes.

Procedure

Modifying and Saving the Color Palette

You cannot modify Allegro PCB Editor’s global palette. However, you can modify and save the global palette as a local palette. Then, you can read the local palette into any other board design.

1. In the Color and Visibility dialog box, choose Write Local from the drop-down menu under the Palette section.

   This creates a lallegro.col file in the $HOME/pcbenv directory.

2. To apply these colors to another board, open cds_routed.brd.

   Do not save the changes to cds_routed1.brd.

3. Use one of these commands to display the Color and Visibility dialog box:

   □ From the menu bar, choose Display – Color/Visibility.

   □ At the console window prompt, type color.

   □ At the icon toolbar, click .

   Notice the color in the number 13 block in the Palette section.

4. Choose Read Local from the drop-down menu in the Palette section to use the lallegro.col file with the cds_routed.brd design file.

   Notice the color in the number 13 box in the Palette section of the Color and Visibility dialog box.
5. Click Apply and OK.
   
   This action affects only the 24-color palette and not the class/subclass settings.

6. Exit Allegro PCB Editor without saving changes to the cds_routed.brd file.

Summary

You now know how to turn on the visibility of classes and subclasses, apply colors to subclasses, customize colors, and modify and save a palette.

You have learned the following:

- **New menu bar command**: Display – Color/Visibility
- **New console command**: color
- **New toolbar icon**: 🔴
- **New Palette commands**: Write Local, Read Local
- **New dialog boxes**: Color and Visibility, Color Editor
- **New file**: lallegro.col

For More Information

See:

- the *Getting Started with Physical Design* user guide in your documentation set.
- `color` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- “Assigning Colors to Grids, Ratsnest Lines, Highlight, and Background” in the *Allegro Front-to-Back User Guide*.
- `env File`
What’s Next

Go to Lesson 3-3: Controlling Etch Visibility to learn how to control etch visibility, turn on or off layers or design objects, and separately control the etch routing layers from plane layers as well Etch, Pins, Vias, and DRCs classes.

Lesson 3-3: Controlling Etch Visibility

Overview

The Visibility tab on the Control panel lets you turn on or off layers or design objects. Once you assign colors to each class of design object (see Lesson 3-2: Controlling Color and Visibility on page 89), you can use the Visibility tab to selectively display Etch, Pin, Via, and DRC classes on each layer of the design. The Visibility tab displays the color assigned to a design object when that object is visible and the background color of the Design window when the design object is invisible.

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane Layers

Include Plane L
In this lesson, you will learn how to turn on or off layers or design objects and separately control the etch routing layers from plane layers, as well as Etch, Pin, Via, and DRC classes.

Demo

Controlling Etch Visibility

This demonstration runs for approximately 2 1/2 minutes.

Procedure

Start Allegro PCB Editor and open cdsc_routed_DRC.brd.

1. Use one of these commands to zoom into your design:
   - From the menu bar, choose View – Zoom Fit.
   - At the console window prompt, type zoom fit.
   - At the icon toolbar, click .
   - Press F9.

2. In the Visibility tab of the Control Panel, uncheck the boxes in the All column in the Conductors row.

   This turns off visibility for all etch, pins, vias, and DRCs for the conductor layers.

3. Check the box next to Planes, if it is not already checked.

   This displays the visibility check boxes for etch, pins, vias, and DRCs subclasses for the Plane layers.

4. Check the All box in the Planes row to turn on the visibility for etch, pins, vias, and DRCs for the plane layers.

5. Uncheck the All box in the Planes row.

6. Check the Etch box in the Conductors row to control an individual object. Look for changes in the Design window.

7. Check the Pin box in the Conductors row to control an individual object. Look for changes in the Design window.

8. Check the Via box in the Conductors row to control an individual object. Look for changes in the Design window.
9. Check the DRC box in the Conductors row to control an individual object. Then zoom into the area around the D1 diode (x, y coordinates of 2700, 1910). View the DRCs.

10. Uncheck the box next to Planes.

   Notice that the plane layers are removed from the Visibility tab. This may make it easier to view, depending on the layers in your design.

Summary

You now know how to turn on or off layers or design objects and to separately control the etch routing layers from plane layers, as well as Etch, Pins, Vias, and DRCS classes.

For More Information

See the Getting Started with Physical Design user guide in your documentation set.

What’s Next

Go to Lesson 3-4: Controlling Colors and Dimming Graphics to learn how to use levels of visibility based on the importance of the object.

Lesson 3-4: Controlling Colors and Dimming Graphics

Overview

The Graphics Dimming or Shadow Mode option provides distinct levels of visibility based on the object importance. You use Shadow Mode with the hilight and dehilight commands, as well as various interactive commands.
In this lesson, you will learn how to use levels of visibility in your design based on the importance of the object.

Demo

Controlling Colors and Dimming Graphics

This demonstration runs for approximately 3 minutes.

Procedure

1. With `cds_routed.brd` displayed in the Design window, use one of these commands to display the Color and Visibility dialog box:
   - From the menu bar, choose Display – Color/Visibility.
   - At the console window prompt, type `color`.
   - At the icon toolbar, click .

2. From the Group drop-down list, choose Display.
3. To change the background color, click *Background* and choose a color in the Color Editor dialog box. Use the slider to adjust the color shade.

4. Click *OK* in the Color Editor dialog box.

5. Click on *Shadow mode* (shadow mode is normally disabled).

   - The *Brightness* setting slide bar moves to its last applied percentage of brightness. The initial default percentage setting is 40%.

   - The colors in the *Palette* section dim to the chosen percentage of brightness in the slide bar. This lets you preview how the colors in the design are displayed if you click *Apply* or *OK*.

   - The *Dim active layer* check box lets you dim the active layer of a design. Dimming the active layer if it contains a large number of objects displayed normally (non-highlighted) increases the effectiveness of shadow mode. You can dim the active layer using the check box in the Color and Visibility dialog box or the *Options* tab when shadow mode is turned on and you have clicked *Apply*.

   - The design objects of the current active drawing dim to the percentage of brightness set in the slide bar.

6. Drag the *Brightness* slide bar in either direction.

   Notice that the colors in the *Palette* section change, giving you the opportunity to see how the changes will actually appear.

7. Click *OK* to apply and close the Color and Visibility dialog box.

8. Notice how the color of the current *Active Class and Subclass* as defined in the *Options* tab is displayed at the normal color, while all others are drawn at the dimmed color.

9. Change the *Active Class* in the *Options* tab to *Board Geometry* and the *Active Subclass* to *Outline*.

   Notice now that the board outline is drawn at the normal color and everything else is displayed at the dimmed color. Be sure that *Dim active layer* is unchecked in the *Options* tab when you are using shadow mode.

10. To turn off shadow mode, use one of these commands:
At the console window prompt, type `shadow toggle`.
- Click ``.  

Summary

You now know how to use levels of visibility based on the importance of the object. With Shadow Mode turned on, you can control the color intensity of the non-important objects. The higher the brightness percentage, the less difference in color between the important and the non-important objects.

You have learned the following:

- **New term**: shadow mode
- **New console commands**: `toggle`, `shadow toggle`
- **New toolbar icon**:  

Group set to **Display**

Shadow mode feature
For More Information

See:

- the *Getting Started with Physical Design* user guide in your documentation set.
- `toggle` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- `shadow toggle` command in the *Allegro PCB and Package Physical Layout Command Reference*.

What’s Next

Go to Lesson 3-5: Using the Control Panel to Manipulate Design Objects to learn how to find object types, objects by name, and objects by property.

Lesson 3-5: Using the Control Panel to Manipulate Design Objects

Overview

In Allegro PCB Editor, the area to the right of the Design window is the Control Panel. You can toggle among the *Options*, *Find*, and *Visibility* tabs.

Based on the command you are running, the parameters in the *Options* tab change. When you choose a command, the *Options* tab changes to reflect the appropriate class and the default subclass (the first subclass on the list for that class). The parameters and values you set in the *Options* tab take effect immediately. They override definitions for the same parameters and values that you may have already defined using the menu bar or console commands.

For example, Allegro PCB Editor uses the Drawing Options dialog box (*Setup – Drawing Options* from the menu bar; `status` at the console window prompt) for rotation and text values. However, if you place different values in the *Options* tab, the Allegro PCB Editor ignores the information in the Drawing Options dialog box and uses
the values in the **Options** tab. See Lesson 4-4: Choosing Drawing
**Options** on page 137 for additional information.

By default, the Control Panel is docked to the right of the Design window. You can change the position of the Control Panel. For additional information, see **Lesson 5-1: Customizing Your View and Toolset** on page 159.

In the next three procedures, you will learn how to perform these tasks:

- **Finding Objects by Type**
- **Finding Objects by Name**
- **Finding Objects by Property**

**Demo**

- **Finding Objects by Type**
This demonstration runs for approximately 4 minutes.

Procedure

Finding Objects by Type

1. With cds_routed.brd displayed in the Design window, click the Find tab in the Control Panel to bring the Find Filter to the front of the display.

2. Use one of these commands to run the move command:
   - From the menu bar, choose Edit – Move.
   - At the console window prompt, type move.
   - Click .

3. In the Find tab, click All On.
   This ensures that check boxes of all appropriate objects are toggled on. All but one of the available objects has been chosen.
in the *Find* tab. Other objects are not available (grayed out) for this command.

4. Zoom into the left side of the *cds_routed.brd* file and click on the reference designator *U3* (x, y coordinates 25, 1775).

Part U3 snaps to your cursor. In the *Design Objects Find Filter* section of the *Find* tab, *Symbols* is checked, or toggled on. Allegro PCB Editor treats the reference designator you selected as *part of* the package symbol. Because *Symbols* is higher in the selection hierarchy than the reference designator *Text*, Allegro PCB Editor selects the item at the higher level.

When you check more than one object in the *Design Object Find Filter* section, Allegro PCB Editor prioritizes selection by going from top to bottom in the left column of objects and then top to bottom in the right column of objects to find the chosen design elements that are of the highest priority object type.
5. With the cursor in the Design window, click the right mouse button.

A pop-up menu appears with options for the active move command.

**Note:** When you have multiple selections in the Find Filter and your cursor is clicked in a location that has multiple objects, such as a symbol and a cline, you can click the right mouse button and choose *Reject* from the pop-up menu. The Reject Item Selection dialog box appears. You can choose one of the other objects listed in the dialog box to be acted upon by the current command even though the object is lower in the hierarchy shown on the Find Filter.

6. Choose *Oops* from the pop-up menu.

Part U3 snaps back to its original location. The move command remains activated.

7. In the *Find* tab, click *All Off*, then click only the box next to *Text*.

All items in the *Find* tab are unchecked except for *Text*.

8. Click the reference designator text for *U3* again.

This time, part *U3* does not snap to the cursor. Instead, only the reference designator text snaps to the cursor.

Because of the change you made in the *Design Objects Find Filter* section, the reference designator you selected is treated as a text object, and the symbol is not chosen.

9. Click the right mouse button and choose *Cancel* from the pop-up menu.

Text *U3* snaps back to its original location and the move command is deactivated.

---

**Demo**

Finding Objects by Name

This demonstration runs for approximately 3 1/2 minutes.
Procedure

Finding Objects by Name

1. With cds_routed.brd displayed in the Design window, use one of these commands to run the hilight command:
   - From the menu bar, choose Display – Highlight.
   - At the console window prompt, type hilight.
   - Click .

2. Click on the Options tab in the Control Panel to check your highlighting color (Perm highlight).

3. Click the Find tab. In the Find by Name box, verify that Net is chosen from the drop-down menu.

4. In the Find by Name box, verify that Name is chosen from the drop-down menu.
   
   You can choose either Name or List. If you choose List, the data typed in the tab is not a design object, but the name of a text file that contains a list of the names for the design object. Each
name in the file must be on a separate line.

5. In the blank text box below *Net*, type GND and press Enter.

You can use wildcard characters such as * or ? as part of the name or by itself. The selections in the *Design Object Find Filter* section are ignored.

6. Zoom into the design.

The net named *GND* is highlighted.

Note: If you enabled the *no_zoom_to_object* environment variable in the User Preferences Editor dialog box, Allegro PCB Editor does not zoom into the design.

7. If it is difficult to see the highlighted net, follow these steps and then view the highlighted GND net:

   a. Choose *Setup – Drawing Options*.

   b. Click the *Display* tab to bring it forward.

   c. In the *Enhanced Display Modes* section, click *Filled Pads*.
d. Click OK.

8. Use one of these commands to run the `dehilight` command:

   - From the menu bar, choose *Display – Dehilight*.
   - At the console window prompt, type `dehilight`.
   - Click 🌟.

9. Click the GND net.

   All highlighting is removed.

10. With the cursor in the Design window, click the right mouse button and choose *Done* from the pop-up menu.

Demo

Finding Objects by Property

This demonstration runs for approximately 2 minutes.

Procedure

Finding Objects by Property

You can find objects by specifying the properties attached to them. A property is a name or a value pair assigned to a particular object. For Allegro PCB Editor, the property name is an identifier, a string of not more than 32 characters that includes letters, digits, and underscores (_) and starts with a letter. Some examples of property names are: *SIZE*, *ROUTE_PRIORITY*, and *PART_NAME*.

1. With `cds_routed.brd` displayed in the Design window, use one of these commands to run the `hilight` command:

   - From the menu bar, choose *Display – Highlight*.
   - At the console window prompt, type `hilight`.
   - Click 🌟.

2. Click the *Find* tab in the Control Panel to bring it to the front of the display.
3. Under the *Find by Name* text box, choose *Property* from the drop-down list if it is not already chosen.

4. Click *All On* in the *Design Object Find Filter* section.

   This ensures that all relevant check boxes are toggled on, limited to *Symbols, Functions, Nets, Pins*, and *DRC errors*. The *Property* option under the *Find by Name* box uses the active selections in the *Design Object Find Filter* section.

5. Click *More* to display the Find By Name or Property dialog box listing properties that exist in your design.

To obtain a complete listing of available properties, make sure that all the buttons in the *Design Object Find Filter* section are toggled on.

6. Scroll down and choose the *MIN_LINE_WIDTH=15* property and click *Apply*.
You just highlighted your special voltage nets. All nets with an assigned MIN_LINE_WIDTH property of 15 are highlighted in the Design window. The V12N, GND_EARTH, AGND, and V+12 nets in this design have a MIN_LINE_WIDTH property attached to them.

7. Click Cancel to close the Find by Name or Property dialog box.

8. With the cursor in the Design window, click the right mouse button and choose Cancel from the pop-up menu.

The hilight command is no longer active.

Summary

You now know how to how to select object types in your design based on the selections active in the Find Filter, and find an object by name or property.

- **New menu commands**: Edit – Move, Display – Highlight, Display – Dehilight
- **New console commands**: move, hilight, display, param, dehilight
- **New toolbar icons**: ![icon1], ![icon2], ![icon3]
- **New dialog box**: Find by Name or Property
- **New environment variable**: no_zoom_to_object

For More Information

See:

- the Getting Started with Physical Design user guide in your documentation set.
- move command in the Allegro PCB and Package Physical Layout Command Reference.
- hilight command in the Allegro PCB and Package Physical Layout Command Reference.
- display param command in the Allegro PCB and Package Physical Layout Command Reference.
Lesson 3-6: Highlighting Objects

Overview

You can highlight and display database objects in certain colors when the location is unknown in your design, or so that you can see where the objects are placed or how they are routed. Highlighting is particularly useful on very large, densely populated designs.

The type of database object highlighted is based on the selections active in the Find Filter. You can choose your highlight color from up to 24 different colors in the Options tab. Once highlighted, the objects remain highlighted until you dehighlight them.

Demo

Highlighting Objects

This demonstration runs for approximately 4 minutes.

Procedure

1. With cds_routed.brd displayed in the Design window, zoom into the area around the U3 part (x, y coordinates 25, 1775), located at the left side of the design near the center.

   Note: If you enabled the no_zoom_to_object environment variable in the User Preferences Editor dialog box, Allegro PCB Editor does not zoom into the design. If you set the display_no_hilitefont environment variable, Allegro PCB Editor controls how objects are highlighted. The default is to display the highlighted objects with a combination of the
highlight color and the color assigned to the object. For additional information on setting environment variables, see Lesson 5-3: Setting Environment Variables on page 167.

2. Use one of these commands to run the hilight command:
   - From the menu bar, choose Display – Highlight.
   - At the console window prompt, type hilight.
   - Click .

3. Click the Options tab in the Control Panel to bring it to the front of the display.
   The Options tab changes to display the available colors and the current permanent highlight color.

   ![Options tab diagram]

4. Click on the red color button to designate red as the active color for permanent highlighting.

5. Click the Find tab to bring it forward in the Control Panel.

6. Change the setting in the Find by Name list to Symbol (or Pin) as shown and type U3 in the fill in (>) text box.

7. Press the Enter or Return key.
U3 becomes highlighted. You can also see the highlighted part in the World View window.

8. Use one of these commands to run the dehilight command:
   - From the menu bar, choose Display – Dehighlight.
   - At the console window prompt, type dehilight.
   - Click .

9. If the Find Filter is covered by the Options tab, click the Find tab to bring it forward.

10. Enter * in the fill in (>) text box under Find by Name in the Find Filter.

11. Press the Enter or Return key.

   You just removed all the permanent highlights from your design.

12. Click the right mouse button in the Design window and choose Done from the pop-up menu.

   You can use highlights for objects, critical nets, pins, properties, or any of the items available in the Find Filter.

**Summary**

You now know how to highlight and dehighlight objects in a design.

You have learned the following:

- **New environment variable:** display_nohilitefont
For More Information

See the *Getting Started with Physical Design* user guide in your documentation set.

What’s Next

Go to Lesson 3-7: Listing Detailed Information About a Specified Object to learn how to obtain detailed information about a specified object.

Lesson 3-7: Listing Detailed Information About a Specified Object

Overview

In Allegro PCB Editor, you can obtain information about an item in the design. Using the Find Filter, you can determine the type of information that will be displayed. Based on the Find Filter settings, you can choose a net name, a component’s reference designator, the padstack a pin uses, and so on. Allegro PCB Editor selects the highest-level object that is associated with that selection. If you disable the higher-level elements, Allegro PCB Editor selects lower-level objects. For example, a pin can be part of a function, net, symbol, component, or group. When determining the proper object to highlight, Allegro PCB Editor uses this hierarchy:

- Groups
- Components
- Symbols
- Functions
- Nets
- Pins
Demo

Listing Detailed Information About an Object

This demonstration runs for approximately 7 1/2 minutes.

Procedure

1. With cds_routed.brd displayed in the Design window, zoom into a view area around the U2 component (x, y coordinates 755, 1980).

   U2 is a long DIP component located just left of the board center and to the right of the three SOICs at the left side of the design.

2. Use one of these commands to run the show element command:
   - From the menu bar, choose Display – Element.
   - At the console window prompt, type show element.
   - Click .
   - Press F5.

3. Click the Find tab in the Control Panel to bring the Find Filter to the front of the display.

4. Click All On.

   This ensures that the check boxes for all objects are toggled on. Only the Groups box remains unchecked because there are no groups in the design.

5. Move the mouse to place the cursor on one of the pins of the U2 component that contains etch connected to the pin, and click the left mouse button to select it.

   The Show Element report appears. If your Show Element report window is covering the Find Filter, move it so you can also see the Find Filter.

   At the top of the Show Element report is a description of the type of object that is chosen, <COMPONENT INSTANCE>. The data in this report corresponds to a description of the component instance of the Comps item in the Find Filter because the
6. In the Find Filter, disable the check box next to *Comps*.

7. Select the same pin on the same component again.

   This time, the Show Element report refreshes to display `<SYMBOL>` information for this component package.

   This report focuses on the characteristics of the physical package symbol, and corresponds to the *Symbols* entry in the Find Filter. *Symbols* is now the priority item in the Find Filter. If more than one item in the Find Filter is turned on, then the priority goes to the highest active item in the list.

8. In the Find Filter, disable *Symbols* and select the same pin again.

   The Show Element report refreshes to display `<FUNCTION INSTANCE>` information for this package. This information corresponds to the Functions entry in the Find Filter. The pin you selected is seen as part of a function or gate within this package.

9. In the Find Filter, disable *Functions* and select the same pin again.

   The Show Element report refreshes to display `<NET>` information for this pin. This information corresponds to the *Nets* entry in the Find Filter. Notice the information about etch length and any attached properties.

10. In the Find Filter, disable *Nets* and select the same pin again.

    The Show Element report refreshes to display `<CONNECT PIN>` information. This information corresponds to the *Pins* entry in the Find Filter. Notice the padstack information.

11. In the Find Filter, disable *Pins* and select the same pin again.

    The Show Element report refreshes to display `<CONNECT LINE>` information for the connection to the pin. This information corresponds to the *Clines* (etch) entry in the Find Filter.


13. Click the right mouse button in the Design window and choose *Cancel* from the pop-up menu.
Selecting the same object generates different information, based on the settings in the Find Filter. It is not just which item you select, but also the selection priority in the Find Filter that matters.

When using the Display – Element menu command, disable all the objects in the Find Filter. Then enable only the object(s) that generate the information you want to see.

Summary

You now know how to list the attributes of a specified object.

You have learned the following:

- New menu bar command: Display – Element
- New console command: show element
- New toolbar icon:     
- New function key command: F5
- New dialog box: Show Element

For More Information

See:

- the Getting Started with Physical Design user guide in your documentation set.
- show element command in the Allegro PCB and Package Physical Layout Command Reference.

What’s Next

Go to Lesson 3-8: Measuring Distance Between Objects.
Lesson 3-8: Measuring Distance Between Objects

Overview

In Allegro PCB Editor, you can measure distance between two objects. The Find Filter settings determine which database objects are chosen. If the selection point does not contain any items that match the Find Filter settings, then Allegro PCB Editor uses the closest grid point to determine the distance. After you select the two points, a window appears detailing information about the distance between the two elements. Information displayed includes total distance, manhattan distance, the delta X and delta Y, and the air gap.

The manhattan distance is the orthogonal distance between two points. The distance is calculated as the sum of the distance between the points along the X axis and the distance between the points along the Y axis: $DX + DY$. The air gap is the closest, shortest straight line.
between the two elements. It is displayed only if the two chosen elements reside on the same class and subclass.

**Demo**

Measuring Distance Between Objects

This demonstration runs for approximately 3 minutes.

**Procedure**

1. With `cds_routed.brd` displayed in the Design window, click the *Options* tab in the Control Panel to bring it forward.

2. Set the Active Class to *Etch* and the Subclass to *Top*, as shown below.
3. Use one of these commands to run the `show measure` command:

- From the menu bar, choose `Display – Measure`.
- At the console window prompt, type `show measure`.

The Allegro PCB Editor message area prompts you as follows:

```
Make two picks for calculator
```

4. Choose two objects between which you want to measure the distance. Remember to check the settings in the Find Filter.

The Measure report appears, showing information about the objects chosen, the manhattan distance, and air gap information.

5. To exit this mode, click the right mouse button and choose `Done` from the pop-up menu.


An Exit window appears, asking if you want to save any of the changes made to your current design.

7. Click `No`.

Allegro PCB Editor closes. You exit Allegro PCB Editor software.

**Summary**

You now know how to measure the distance between two design objects.

- **New terms:** manhattan distance, air gap
New menu bar command: Display – Measure

New console command: show measure

For More Information

See:

- show measure command in the Allegro PCB and Package Physical Layout Command Reference.

What’s Next

Go to Module 4: Using Allegro PCB Editor Design Editing Functions to learn some basic design editing functions.
Module 4: Using Allegro PCB Editor Design Editing Functions

This module comprises these lessons:

- **Lesson 4-1: Naming a Symbol and Setting Drawing Parameters** on page 126
- **Lesson 4-2: Setting the Grid for a Design** on page 130
- **Lesson 4-3: Creating a Board Outline** on page 132
- **Lesson 4-4: Choosing Drawing Options** on page 137
- **Lesson 4-5: Defining the Stackup** on page 143
- **Lesson 4-6: Associating Design Objects with Classes and Subclasses** on page 148
- **Lesson 4-7: Adding Arches to a Design** on page 150
- **Lesson 4-8: Adding Circles to a Design** on page 152
- **Lesson 4-9: Adding Text to a Design** on page 154
- **Lesson 4-10: Using Zcopy** on page 156

**Completion Time**

It should take approximately 90 minutes to complete the written lessons in this module.
Lesson 4-1: Naming a Symbol and Setting Drawing Parameters

Overview

Lessons 4-1 through 4-3 have procedures to set parameters for a design and create a board outline. Although these procedures do not follow the recommended methodology for creating a board outline, they provide a useful exercise to introduce symbol mode and let you create a mechanical drawing.

In this lesson, you will name a symbol and set drawing parameters for a design.

Demo

Naming a Symbol and Setting Drawing Parameters

This demonstration runs for approximately 2 minutes.

Procedure

1. Start Allegro PCB Editor software. If you need additional information, see Lesson 1-2: Starting Up Allegro PCB Editor on page 51.

2. Use one of these commands to start a new drawing:

   - From the menu bar, choose File – New.
   - At the console window prompt, type new.
   - At the icon toolbar, click .

   The New Drawing dialog box appears.

3. In the Drawing Name text box, type my_outline.
4. Choose *Mechanical symbol* from the scrolling list of drawing types, as shown below.

![New Drawing dialog box](image)

5. Click OK to close the New Drawing dialog box.

   Allegro PCB Editor displays symbol mode. The title bar changes to Allegro Mechanical.

6. Use one of these commands to set up drawing parameters:

   a. From the menu bar, choose *Setup – Drawing Size*.

   b. At the console window prompt, type `drawing param`.

   The Drawing Parameters dialog box appears. Use this dialog box to control the size, origin, number of decimal places, and user units of the drawing.
Allegro PCB Editor Tutorial
Module 4: Using Allegro PCB Editor Design Editing Functions

7. From the *Size* drop-down list, choose *A*.

8. In the *Accuracy* list box, click the arrow until *2* appears in the box.

   The accuracy should match or be less than the accuracy of your board file.

9. Change the *Left X* and *Lower Y* text boxes in the *DRAWING EXTENTS* section to match the values in the Drawing Parameters dialog box shown above.

   These settings cause the drawing origin to be placed 2 inches (2000 mils) up and to the right of the lower-left corner of the drawing.
If you type a value in the *MOVE ORIGIN* section, it causes cumulative results. An easier method for setting the origin point for this instance is to change the coordinates in the *DRAWING EXTENTS* text boxes.

**Note:** To advance to the next field in any Allegro PCB Editor dialog box, use the Tab key. Do not press the Enter key. Pressing the Enter key has the same results as clicking OK. It closes the dialog box and executes the commands.

10. **Click OK** to save the drawing parameters and close the Drawing Parameters dialog box.

### Summary

You now know how to name a symbol and set drawing parameters.

You have learned the following:

- **New menu bar command:** *File – New*
- **New console command:** `new`
- **New toolbar icon:** 
- **New dialog boxes:** New Drawing, Drawing Parameters

### For More Information

See:

- the *Getting Started with Physical Design* user guide in your documentation set.
- `new` command in the *Allegro PCB and Package Physical Layout Command Reference*.

### What’s Next

Go to Lesson 4-2: Setting the Grid for a Design to learn how to define a grid.
Lesson 4-2: Setting the Grid for a Design

Demo

Setting the Grid for a Design

This demonstration runs for approximately 1 minute.

Procedure

1. Use one of these commands to define the grid for my_outline.dra:
   - From the menu bar, choose Setup – Grids.
   - At the console window prompt, type define grid.
The Define Grid dialog box appears.

2. In the *Non-Etch* section at the top of the dialog box, make the following spacing changes:

   a. Click in the *Spacing: x* text box, type 25, and press Tab.

   b. Click in the *Spacing: y* text box, type 25, and press Tab.

3. Click *OK* to save the changes and close the dialog box.

**Summary**

You now know how to define a grid.
You have learned the following:

- **New menu bar command**: *Setup – Grids*
- **New console command**: `define grid`
- **New dialog box**: Define Grid

**For More Information**

See:

- the *Getting Started with Physical Design* user guide in your documentation set.
- `define grid` command in the *Allegro PCB and Package Physical Layout Command Reference*.

**What’s Next**

Go to Lesson 4-3: Creating a Board Outline to learn how to create a board outline.

**Lesson 4-3: Creating a Board Outline**

**Overview**

In this lesson, you will use the `add line` command to create a board outline.

**Note**: The datum (0,0) point for this outline is inside the lower-left corner of the board.

**Demo**

Creating a Board Outline

This demonstration runs for approximately 2 1/2 minutes.
Procedure

1. Use one of these add line commands to add a board outline to my_outline.dra:
   - From the menu bar, choose Add – Line.
   - At the console window prompt, type add line.
   - At the icon toolbar, click .

2. In the Options tab of the Control Panel, click Active Class to Board Geometry and Subclass to Outline, if necessary.
   For information about classes and subclasses, see Lesson 4-6: Associating Design Objects with Classes and Subclasses on page 148.

3. Use the drop-down lists and text box to specify these values in the Options tab of the Control Panel:
   - Line lock – Line 45
   - Line width – 8
   - Line font – Solid

4. In Allegro PCB Editor, you can pick points on the screen to specify coordinates, or you can specify the coordinates at the console window prompt. Type each line of values at the console window prompt and press Enter after each entry. In this list, first you set absolute values for the x and y coordinates; then you set relative values—just the increment for a specified coordinate. ix means to increment the x coordinate by the specified value; iy means to increment the y coordinate by the specified value.
   - x -1000 0
   - x -150 0
   - x -150 -200
   - ix 4100
   - iy 4500
   - ix -4100
   - iy -200
Or you can use the `pick` and `ipick` commands.

a. At the console window prompt, type `pick`.

b. In the dialog box, type the value for the x coordinate and then click `OK`.

   **Note:** The dialog box is labeled Pick and the fields are different if you are running a release later than Release 15.0.

c. In the dialog box, type the value for the y coordinate and then click `OK`.

d. For the incremental coordinates, type `ipick` at the console window prompt.

e. In the dialog box, type the incremental value for the x coordinate and then click `OK`.

f. In the dialog box, type the incremental value for the y coordinate and then click `OK`.

5. Click the right mouse button and choose *Done* from the pop-up menu. Your outline should look like the outline shown below.
**Note:** If you are running a release later than Release 15.0, you do not need to perform step 1. The symbol and drawing are both saved when you perform step 2.

1. Use one of these commands to save the symbol (my_outline.bsm):
   - From the menu bar, choose *File – Create Symbol*.
   - At the console window prompt, type `create symbol`.

2. Use one of these commands to save the drawing (my_outline.dra):
   - From the menu bar, choose *File – Save*.
   - At the console window prompt, type `save`.
   - Click .
Summary

You now know how to use the add line function to create a board outline.

You have learned the following:

- **New terms:** ix, iy
- **New menu commands:** Add – Line, File – Save
- **New console commands:** add line, save, pick, ipick
- **New toolbar icons:**

For More Information

See:

- “Creating a Board Outline” in the *Front to Back Methodology Guide*.
- `add line` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- `save` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- `pick` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- `ipick` command in the *Allegro PCB and Package Physical Layout Command Reference*.

What’s Next

Go to Lesson 4-4: Choosing Drawing Options to learn how to control Allegro PCB Editor display, set the line lock parameters, and run online design rule checks on your design.
Lesson 4-4: Choosing Drawing Options

Overview

In your design, you can:

- Control the Allegro PCB Editor display.
- Set the line lock parameters.
- Run online design rule checks (DRCs).
- Specify the angle that Allegro PCB Editor uses when you place symbols. You can also mirror symbols that you add to a drawing.

In this lesson, you will learn how to set drawing options for your design.

Demo

Choosing Drawing Options

This demonstration runs for approximately 3 1/2 minutes.

Procedure

1. Open the cds_routed.brd file.

   Be sure that the Files of type list box in the Open dialog box is set to All Files.

2. Using panning and zooming functions, find the U7 component (x, y coordinates: 15, 3545) located in the upper left part of the board and view the pads.

3. Use one of these commands to display the Drawing Options dialog box:
   - From the menu bar, choose Setup – Drawing Options.
   - At the console window prompt, type status.

   The Drawing Options dialog box appears, displaying current settings for various design operations. It is divided into five categories: Status, Display, Text, Line Lock, and Symbol.
4. Click the *Display* tab to bring it forward.

5. Click *Grid, Filled Pads and cline endcaps*, and *Display drill holes*, as shown below, then click *OK*.

**Note:** If you are running a release later than Release 15.0, the information on some of the tabs in the Drawing Options dialog box is different.

The U7 pin pads now look like donuts instead of unfilled polygons, grid points, and drill holes.

6. After viewing the changes on the *U7* component, open the Drawing Options dialog box again and reset the *Display* options in the Drawing Options dialog box to their previous disabled (unchecked) states.
You can also control the size of connect points, DRC markers, and Rat Ts as well as the number of rubberbands displayed, and the geometry of the ratsnest lines.

7. Open the Drawing Options dialog box again, and click the Status tab to get information about your design.

You can use the Status tab to verify the current state of dynamic shapes and DRCs and update them if they are out-of-date. If the DRC errors box is red, choose Update DRC to rerun DRC checks to bring status up-to-date and change the DRC errors box to green.

8. Click the Text tab and review the fields for controlling text in your design. Click Help for additional information on the dialog box.
9. Click the Line Lock tab.
You can specify default values when you add lines to a design or you can override these values if you modify fields in the *Options* tab of the Control Panel.

10. Click the *Symbol* tab.
You can specify the default values when you place symbols or you can override these values if you modify fields in the *Options* tab of the Control Panel.

11. Click *OK* to save changes and dismiss the Drawing Options dialog box.

**Summary**

You now know how to set the drawing options for a design.

You have learned the following:
Lesson 4-5: Defining the Stackup

Overview

A layer is an insulated plane in the design that contains lines of etch. The ordered list of layers in the design is called the stackup or cross section. In Allegro PCB Editor, you define and sequence the layers, identify the type of material used for that layer, and assign a name to each of the layers in the stackup.

By default, all new design files are created with just two layers: TOP and BOTTOM. In this lesson, you will add more layers to the stackup.
Demo

Defining the Stackup

This demonstration runs for approximately 6 minutes.

Procedure

1. Use one of these commands to display the New Drawing dialog box:
   - From the menu bar, choose File – New.
   - At the console window prompt, type new.
   - At the icon toolbar, click .
   
   Click No to indicate that you do not want to save any changes in cds_routed.brd when closing it.

2. Type example1 in the Drawing Name text box.

3. Choose Board in the Drawing Type list and click OK.

4. Use one of these commands to display the Layout Cross Section dialog box:
   - From the menu bar, choose Setup – Cross-section.
   - At the console window prompt, type define xsection.
   - At the icon toolbar, click .

   The Layout Cross Section dialog box appears. This dialog box is used only by Allegro PCB Editor and APD. Other products use a high-speed dialog box.

   Notice that a TOP and BOTTOM layer are already defined by default as conductor layers.
This example shows only the routing layers. You need to add dielectric and core layers to fully model the real design and perform signal integrity analysis on the design.

5. In the Edit column, find the row labeled BOTTOM. Click the arrow in the Edit column of the Bottom row and choose Insert from the menu.

A new layer is inserted in the stackup above the layer you just selected. You can change the layer parameters after the layers are inserted.

6. Repeat step 5 until there are nine layers between the TOP and BOTTOM layers.

7. Set up your stackup to match the layer specifications shown below.
The GND and VCC planes are both labelled negative for the Manufacturing (artwork) output, and DRC checking treats those as negative planes. In this master design file, you added a power and a ground plane and two inner layers for routing. All designs created from this mechanical template start as six-layer boards. However, for this design, only a four-layer board is required.

8. Click on the arrow next to each layer and choose Show.

In the Thickness text box at the bottom of the dialog box, note the default value for the thickness of the layer. These values are different for conductor and dielectric layers. This field is important for high-speed designs. When using the impedance
calculator, it considers layer types and thickness for its calculations.

9. Click the arrow to the left of the dielectric layer above IS1 and choose Delete to delete the layer from the stackup.

10. Repeat step 9 to delete these layers: IS1, the dielectric layer below IS1, and IS2.

The layers are deleted from the design leaving a four-layer design. You can now save the board template so it can be used again.

**Note:** Be sure that you delete all objects on a layer before deleting the layer. Otherwise, an error message appears indicating that you must delete all objects on the layer before deleting the layer.

11. Click OK to close the Layout Cross Section dialog box.

12. Use one of these commands to save the changes:

   - From the menu bar, choose **File – Save**.
   - At the console window prompt, type `save`.
   - Click ![Save](image)

**Summary**

You now know how to define the cross section or stackup.

You have learned the following:

- **New terms:** stackup, cross section,
- **New menu bar command:** `Setup – Cross-section`
- **New console command:** `define xsection`
- **New toolbar icon:** ![New toolbar icon](image)
- **New dialog box:** Layout Cross Section

**For More Information**

See:
Allegro PCB Editor Tutorial
Module 4: Using Allegro PCB Editor Design Editing Functions

- the Preparing for Layout user guide in your documentation set.
- define xsection command in the Allegro PCB and Package Physical Layout Command Reference.

What's Next

Go to Lesson 4-6: Associating Design Objects with Classes and Subclasses to learn how to associate design objects with classes and subclasses.

Lesson 4-6: Associating Design Objects with Classes and Subclasses

Overview

A design file is a composite of a number of design objects. The design objects are categorized by class and subclass. Classes are major categories defining the purpose of the design objects. Subclasses further define the purpose of the design objects. For example, if you are running the add line command on class Board Geometry, subclass Outline, Allegro PCB Editor adds a simple geometric graphic element, such as board outline, to a design. However, if you are running the add line command and Etch is the active class, Allegro PCB Editor adds lines of etch to the design.

There are 21 classes to which you can associate design objects. These classes come with some pre-defined subclass names that are most commonly used in board design. You can also define your own subclasses for 11 of the 21 classes.

In this lesson, you will define a subclass and associate design objects with classes and subclasses.

Demo

Associating Design Objects with Classes and Subclasses

This demonstration runs for approximately 2 1/2 minutes.
Procedure

1. With example1.brd displayed in the Design window, use one of these commands to access the Define Subclasses dialog box:
   - From the menu bar, choose Setup – Subclasses.
   - At the console window prompt, type define subclass.

2. In the Define Subclasses dialog box, click Board Geometry.

3. In the Define Non-Etch Subclass dialog box, type my_subclass in the New Subclass text box and press the Enter or Return key.
   
   **Note:** If you press the arrow next to the name of the new subclass, you can delete it. However, you need to delete all the design objects on the subclass before you can delete the subclass.

4. Click OK in the Define Subclass dialog box to save the subclass and dismiss the dialog boxes.

5. Verify in the Options tab of the Control Panel that the active class is Board Geometry and the subclass is My_S subclass.

6. Use one of these commands to add a rectangle:
   - From the menu bar, choose Add – Rectangle.
   - At the console window prompt, type add rect.
   - At the icon toolbar, click .

7. In the Design window, start drawing a rectangle and click another point to complete the drawing.

8. Click the right mouse button and choose Done from the pop-up menu to exit the command.

9. From the menu bar, choose File – Save.

10. Click Yes to overwrite the file.

   The rectangle design object is associated with the Board Geometry class and My_Subclass.
Summary

You now know how to associate a design object with a class and subclass pair.

You have learned the following:

- **New terms:** class, subclass
- **New menu commands:** Setup – Subclasses, Add – Rectangle
- **New console commands:** define subclass, add_rect
- **New toolbar icon:**
- **New dialog boxes:** Define Subclasses, Define Non-Etch Subclass

For More Information

- the *Getting Started with Physical Design* user guide in your documentation set.
- `define subclass` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- `add rect` command in the *Allegro PCB and Package Physical Layout Command Reference*.

What’s Next

Go to *Lesson 4-7: Adding Arcs to a Design* to learn how to add arcs to a design.

Lesson 4-7: Adding Arcs to a Design

Overview

In Allegro PCB Editor, adding an arc requires three points: a point to start the arc, an end point, and a third point to determine the radius.
of the arc. To create an arc, specify three points either by mouse click or typing cursor coordinates at the command line.

Demo

Adding Arcs to a Design

This demonstration runs for approximately 1 1/2 minutes.

Procedure

1. With example1.brd displayed in the Design window, verify that **Active Class** is **Board Geometry** and **Subclass** is **My_Subclass** in the **Options** tab of the Control Panel.

2. Use one of these commands to add an arc:
   - From the menu bar, choose **Add – 3pt Arc**.
   - At the console window prompt, type **add arc**.

3. Specify these values in the **Options** tab of the Control Panel:
   - **Line Width** – 5
   - **Font** – Solid

4. Pick the start point of the arc, the end point, and a third point that dynamically establishes the radius of the arc.

5. Click the right mouse button and choose **Done** from the pop-up menu to make the arc permanent, or pick another three points for the next arc.

6. Use one of these commands to save the file:
   - From the menu bar, choose **File – Save**.
   - At the console window prompt, type **save**.
   - Click 🔄.

7. Click Yes to overwrite the file.
Summary

You now know how to add arcs to a design.

You have learned the following:

- **New menu bar command:** *Add – 3pt Arc.*
- **New console command:** *add arc*

For More Information

See the *Preparing for Layout* user guide in your documentation set.

What’s Next

Go to Lesson 4-8: Adding Circles to a Design to learn how to add circles to a design.

Lesson 4-8: Adding Circles to a Design

Demo

*Adding Circles to a Design*

This demonstration runs for approximately 1 1/2 minutes.

Procedure

1. With *example1.brd* displayed in the Design window, verify that the *Active Class* is *Board Geometry* and the *Subclass* is *My_Subclass* in the *Options* tab of the Control Panel.

2. Use one of these commands to add a circle:

   - From the menu bar, choose *Add – Circle*.
   - At the console window prompt, type *add circle*.

   The following message appears:

   *Pick center point of circle*
3. Specify these values in the Options tab of the Control Panel:
   - Line Width – 5
   - Font – Solid

4. Move the cursor to the position you want to be the center of the circle, and click the left mouse button.

   The following message appears:
   Pick a perimeter point on the circle.

5. Click again to specify the radius.

6. Repeat steps 4 and 5 for each circle you draw.

7. When all circles are complete, click the right mouse button and choose Done from the pop-up menu.

8. Use one of these commands to save the file:
   - From the menu bar, choose File – Save.
   - At the console window prompt, type save.
   - Click .

9. Click Yes to overwrite the file.

**Summary**

You now know how to add circles to a design.

You have learned the following:

- **New menu bar command:** Add – Circle
- **New console command:** add circle

**For More Information**

See:
- Circles in the Allegro PCB Editor User Guide or Circles in the Allegro Package Designer User Guide.
Lesson 4-9: Adding Text to a Design

Overview

You can add text to Allegro PCB Editor designs as simple notes and as logical labels of elements. Labels include reference designators, device type, value, tolerance, and user part number.

You can also specify text size before adding text to your design. For additional information, see the `define text` command.

Demo

This demonstration runs for approximately 2 minutes.

Procedure

1. With `example1.brd` displayed in the Design window, verify that the `Active Class` is `Board Geometry` and the `Subclass` is `My_Subclass` in the `Options` tab of the Control Panel.

2. Use one of these commands to add text:
   - From the menu bar, choose `Add – Text`.
   - At the console window prompt, type `add text`.
   - Click `abc`.

3. Specify these values in the `Options` tab of the Control Panel:
Allegro PCB Editor Tutorial
Module 4: Using Allegro PCB Editor Design Editing Functions

- Disable Mirror.
- Marker Size – 50
- Rotate – 0
- Text block – 16
- Text Just – Left

4. Position the cursor and click at the location for the text and enter the text in the Design window.
   Limit text lines to 200 characters, including spaces.

5. To correct errors, press the Delete or Backspace key.

6. Press the Enter key to start a new line of text with line spacing set by the parameter block.

7. When you have entered all text required for the current point, click the right mouse button and choose Done from the pop-up menu.

8. Use one of these commands to save the file:
   - From the menu bar, choose File – Save.
   - At the console window prompt, type save.
   - Click .

9. Click Yes to overwrite the file.

Summary

You now know how to add text to a design.

You have learned the following:
- New menu bar command: Add – Text
- New console commands: add text, define text
- New toolbar icon: 

July 2006 155 Product Version 15.7
For More Information

See

- the *Getting Started with Physical Design* user guide in your documentation set.
- `add_text` command in the *Allegro PCB and Package Physical Layout Command Reference*.
- “Working with Text” in the *Allegro Front-to-Back User Guide*.

What’s Next

Go to Lesson 4-10: Using Zcopy to learn how to copy a shape and add it to a different class and subclass at the same location in the design.

Lesson 4-10: Using Zcopy

Overview

The `zcopy shape` command lets you copy a shape, closed polygon, or rectangle and add it to a different class or subclass at the same location in your design. In this lesson, you will copy the outline of the J1 component on the left side of `cds_routed.brd` to a new subclass.

Demo

![Using Zcopy](image)

This demonstration runs for approximately 3 minutes.

Procedure

1. Open `cds_routed.brd`. Zoom to fit the design in the window.

2. Define a new subclass called `new_subclass` on the `Board Geometry` class. See Lesson 4-6: Associating Design Objects with Classes and Subclasses on page 148 for information.
3. To find out the design object used to create the \textit{J1} component, use one of these commands:
   \begin{itemize}
   \item From the menu bar, choose \textit{Display – Element}.
   \item At the console window prompt, type \textit{show element}.
   \item Click \textit{i}.
   \item Press F5.
   \end{itemize}

4. In the \textit{Find} tab of the Control Panel, click \textit{All Off}. Then click on \textit{Clines}, \textit{Lines}, and \textit{Shapes}.

5. Zoom in and select the \textit{J1} component on the left side of the drawing.
   The Show Element dialog box shows that the object is \textit{Line}.

6. Close the dialog box, click the right mouse button in the Design window, and choose \textit{Cancel} to cancel the \textit{show element} command.

7. Use one of these commands:
   \begin{itemize}
   \item From the menu bar, choose \textit{Edit – Zcopy}.
   \item At the console window prompt, type \textit{zcopy shape}.
   \end{itemize}

8. In the \textit{Options} tab of the Control Panel, click the \textit{Active Class} to \textit{Board Geometry} and the \textit{Subclass} to \textit{new_subclass} to indicate where the copy will be located.

9. In the \textit{Find} tab, click \textit{All Off}. Then click on \textit{Lines}.

10. Zoom in and select the \textit{J1} component on the left side of the drawing.

    \textbf{Note:} You can use the \textit{Temp Group} command in the pop-up menu to choose more than one element, provided that the items are in the same class and subclass. The command highlights the selected items and identifies the class and subclass of the selected items in the \textit{Class/Subclass} list box in the \textit{Options} tab.

    This message appears in the console window.
    \textit{Copied to: ("Board Geometry/New_Subclass"), 1 copies made}
11. Click the right mouse button and choose Done from the pop-up menu.


Summary

You now know how to copy a shape and change its class and subclass.

You have learned the following:

- **New command:** Edit – Zcopy
- **New console command:** zcopy shape

For More Information

See:

- zcopy shape command in the Allegro PCB and Package Physical Layout Command Reference.

What’s Next

Go to Module 5: Customizing the Environment to learn how to customize the Allegro PCB Editor environment.
Module 5: Customizing the Environment

This module comprises these lessons:

- **Lesson 5-1: Customizing Your View and Toolset** on page 159
- **Lesson 5-2: Defining Aliases and Function Aliases** on page 164
- **Lesson 5-3: Setting Environment Variables** on page 167
- **Lesson 5-4: Running Commands with Strokes** on page 170
- **Lesson 5-5: Scripting** on page 173
- **Lesson 5-6: Using Color Visibility Views** on page 179

**Completion Time**

It should take approximately 90 minutes to complete the written lessons in this module.

**Lesson 5-1: Customizing Your View and Toolset**

**Overview**

In addition to customizing color selections, setting aliases and function aliases, and scripting, you can customize Allegro PCB Editor Control Panel and icon toolbars. You can undock the Control Panel in Allegro PCB Editor, and size and move it as required. You can also perform the following tasks to customize your toolbar:

- Add or remove groups of icons from the toolbar
- Modify the display, such as including tool tips, large buttons, or giving the icons a certain appearance
- Control the icons displayed in each of the toolbar groups
The toolbar settings are stored in a file in the registry on your system. You cannot edit this file. Each time you start the Allegro PCB Editor, the file is read. These settings are not stored in the Allegro PCB Editor database.

The toolbar settings are stored in an Allegro PCB Editor initialization (allegro.ini) file and are read each time you start Allegro PCB Editor. They are not stored in the Allegro PCB Editor database. See Allegro PCB Editor Initialization on page 23.

Demo

Customizing Your View and Toolset

This demonstration runs for approximately 6 minutes.

Procedure

1. Start up the Allegro PCB Editor. For additional information, see Lesson 1-2: Starting Up Allegro PCB Editor on page 51.

2. Use one of these commands to display the Display Option dialog box and determine the new location of your Control Panel:
   - From the menu bar, choose View – Customization – Display.
   - At the console window prompt, type display param.
3. Experiment with the docking options that determine where the Control Panel appears.

4. If the dialog box remains open when you are finished, click OK to dismiss it.

**Note:** To manually dock and undock the Control Panel:

   a. Place your cursor on one of the corners of the Control Panel.

       The cursor turns into a white arrow.

   b. Press and hold the left-mouse button and move the Control Panel to the specified location.

       Lining up the corner of the Control Panel with the corner of the Design window docks the Control Panel.

5. From the menu bar, choose **View – Customization – Toolbar** to display the Customize dialog box.
6. Experiment by checking or unchecking the boxes to turn on and off the various toolbars on the Toolbars tab.

7. Click the Commands tab to bring it forward.

8. Click Route in the Categories list to display available route-related icons.
Notice that there are two Allegro PCB Router router-related icons.

- The first Allegro PCB Router icon opens the Automatic Router dialog box. It lets you use the Allegro PCB Router without exiting Allegro PCB Editor.
- The second Allegro PCB Router icon opens the Allegro PCB Router GUI, but this icon does not appear in the Allegro PCB Editor toolbar.

1. Add the second Allegro PCB Router icon to your toolbar. Click and drag the icon from the Buttons section in the Commands tab to the toolbar area of Allegro PCB Editor. Place it next to the other Allegro PCB Router icon.

2. Click OK to close the Customize dialog box.

3. Reset the options in the Display Option dialog box and the Customize dialog box to their defaults.
Summary

You now know how to position your Control Panel and customize the view of your toolset.

You have learned the following:

- **New menu commands**: View – Customization – Display, View – Customization – Toolbars
- **New console command**: display param
- **New dialog boxes**: Display Option, Customize

For More Information

See:

- the *Getting Started with Physical Design* user guide in your documentation set.
- `display param` command in the *Allegro PCB and Package Physical Layout Command Reference*.

What’s Next

Go to Lesson 5-2: Defining Aliases and Function Aliases to learn how to set aliases and function keys that you can use as shortcut commands.

Lesson 5-2: Defining Aliases and Function Aliases

Overview

The alias command lets you create shortcuts for commands you use most often. In addition to using alphanumeric characters as an alias, you can also use function keys (create a function alias), with or without Shift and Control keys, to execute commands. The alias and function alias are alternative ways of entering the command, but they do not disable the full commands. You can still use the standard form of the command.
Note: The *funckey* command is available only in releases later than Release 15.0.

The *funckey* command lets you create a function alias using alphanumeric keys. The tools support groupings of up to four alphanumeric character keys for operation as a function alias. When keys operate as a function alias, you press the keys and you do not have to press the Enter key, provided that your cursor is not active in the Console window.

Aliases and function aliases work only in the Cadence tool, not at the operating system level. When you create an alias or a function alias, it is active only for the current work session. When you exit the tool and return to the operating system, aliases and function aliases are lost.

To use aliases and function aliases repeatedly, define and save them in your local environment file. Allegro PCB Editor creates a *pcbenv* directory with the *env* file at a location determined by the value of the environment variable HOME. See *env File* on page 24.

Demo

Defining Aliases and Function Aliases

This demonstration runs for approximately 3 1/2 minutes.

Procedure

1. At the console window prompt, type *alias* or *funckey*.

   The Defined Aliases/Funckeys list appears. It lists the default aliases for the typed commands and the function keys. It includes any aliases entered at the site level as well as those that you entered in the local environment file.

   **Note:** If you are running a release later than 15.0, you can choose *Tools – Utilities – Aliases/Function Keys* from the menu bar to display the Defined Aliases/Funckeys list.

2. Close the list.
3. At the console window prompt, type this shortcut and press either the Return or Enter key to set an alias for the Glossing Controller dialog box:

```
alias glp gloss param
```

4. At the console window prompt, now type `glp` and press either the Return or Enter key.

The Glossing Controller dialog box appears.

5. Click Close to dismiss the dialog box.

**Note:** You can do steps 6 through 8 only if you are running a release later than 15.0.

6. At the console window prompt, type this shortcut to create a function alias for the add line command:

```
funckey addl add line
```

7. At the console window prompt, type `addl`. You do not need to press the Enter key. Be sure that the cursor is not active in the console window. The add line command becomes active as though you typed `add line` at the console window prompt.

8. Click the right mouse button in the Design window and choose Cancel from the pop-up menu.

9. Press SF7 (Shift key and F7).

In the Status window, note that you have activated the move command. SF7 is a default function alias for the move command. Other functions keys have already been set as defaults.

10. Click the right mouse button in the Design window and choose Cancel from the pop-up menu to deactivate the move command.

11. Experiment with F1 through F12 keys and SF1 through SF12 keys to see if they are associated with commands.

    Note the command name in the Status window. Except for F1, designated for Help, you can override the default settings for all the other keys.

12. If you are in command mode, click the right mouse button in the Design window, and choose Cancel from the pop-up menu.
Summary

You now know how to create and use aliases and function aliases.

You have learned the following:

- **New console commands:** alias, funckey, gloss
  - param

- **New list:** Defined Aliases/Funckeys list

For More Information

See:

- the *Getting Started with Physical Design* user guide in your documentation set.

- `alias` command in the *Allegro PCB and Package Physical Layout Command Reference*.

- `funckey` command in the *Allegro PCB and Package Physical Layout Command Reference* (available only in releases later than Release15.0).

What’s Next

Go to Lesson 5-3: Setting Environment Variables to learn how to set environment variables.

Lesson 5-3: Setting Environment Variables

Overview

You can set or remove values for Allegro PCB Editor preferences, also known as Allegro PCB Editor environmental variables. These variables set operating conditions for Allegro PCB Editor at the local and site levels.
Demo

Setting Environment Variables
This demonstration runs for approximately 3 1/2 minutes.

Procedure

1. Based on your version of Allegro PCB Editor, use one of these commands:
   - At the console window prompt, type `set`.
   - If you are running a release later than Release 15.0, choose `Tools – Utilities – Env Variables` from the menu bar.

   The Defined Variables list appears. This list includes all the defined environment variables, including those that you defined in your local `env` file as well as those defined at the console window prompt with the `set` command.

2. Scroll down until you find `set pcb_cursor`. Note the setting.

3. Close the list.

4. Use one of these commands to display the User Preferences Editor dialog box:
   - From the menu bar, choose `Setup – User Preferences`.
   - At the console window prompt, type `enved`.

5. In the Categories section of the User Preferences Editor dialog box, click `UI`.

6. In the `pcb_cursor` list, click the arrow to display the drop-down list and choose `infinite`.

   Notice the description in the Summary description section of the dialog box. Also notice the Effective field to the right of the `pcb_cursor` setting. Settings becomes effective immediately, after the next command, or after you restart Allegro PCB Editor.

7. In the `pcb_cursor_angle` text box, type `45`.

8. Click OK to dismiss the dialog box.

9. Use one of these commands:
At the console window prompt, type set.

In the User Preferences Editor dialog box, click List All.

The Defined Variables list appears.

**Note:** If you are running a release later than 15.0, choose Tools – Utilities – Env Variables from the menu bar.

10. Scroll down the Defined Variables list until you reach pcb_cursor and pcb_cursor_angle. Note that the values are the ones that you just set in the User Preferences Editor dialog box.

11. Close the list.

12. Locate your local env file in the pcbenv directory, open it with a text editor, and check the settings for pcb_cursor and pcb_cursor_angle.

All changes you make in the User Preferences Editor dialog box are also saved in your env file. If the env file does not exist, Allegro PCB Editor creates one when you set variables. For additional information on the env file, see env File on page 24.

If you edit the env file, be sure that you add the new information after the source $TELENV statement and before the ###User Preferences section. Otherwise, the Allegro PCB Editor may overwrite the entries.

13. Choose Setup – User Preferences. In the User Preferences Editor dialog box, change the value in the pcb_cursor list to cross.

14. Click OK to dismiss the User Preferences Editor dialog box.

**Summary**

You now know how to set environment variables in the User Preferences Editor, in the env file, and using the set command.

You have learned the following:

- **New menu bar command:** Tools – Utilities – Env Variables
- **New console command:** set
Allegro PCB Editor Tutorial
Module 5: Customizing the Environment

For More Information

See:

- the *Getting Started with Physical Design* user guide in your documentation set.
- `set` command in the *Allegro PCB and Package Physical Layout Command Reference*.

What’s Next

Go to Lesson 5-4: Running Commands with Strokes to learn how to run commands using strokes.

Lesson 5-4: Running Commands with Strokes

Overview

You can define graphical shapes that Allegro PCB Editor interprets as commands. Allegro PCB Editor analyzes the relative motion of the stroke created by the mouse movement, calculates a number for this motion, and then determines whether or not a command is assigned to the shape. Allegro PCB Editor provides a default stroke file, called `allegro.strokes`, which is a binary file.

You can also create your own stroke definitions. Stroke definitions and their associated commands are stored in stroke files that are created and read by the Stroke Editor. You can store these files anywhere on your workstation.

To create a stroke file, or edit an existing stroke file, see the `stroke_editor` command in the *Allegro PCB and Package Physical Layout Command Reference*.

If you can access Allegro Design Entry HDL on Windows, you can use the Stroke Editor that comes with it. You can type `strokes` at the command line and load the `allegro.strokes` file for editing.

Be sure that you do not overwrite the Allegro PCB Editor default `allegro.strokes` file, located in the
$cdsroot\share\pcb\text directory. Allegro PCB Editor looks for stroke files in this order:

1. Current working directory
2. \pcbenv directory
3. $cdsroot\share\pcb\text directory

If you create a new stroke file, store it in your current working directory or in the \pcbenv directory.

In this lesson, you will learn how to use pre-defined strokes to accomplish tasks.

Demo

Running Commands with Strokes

This demonstration runs for approximately 2 1/2 minutes.

Procedure

1. Open cds_routed.brd.
2. Place your cursor in the Design window, then press and hold the Ctrl key on the keyboard while you press and hold the right mouse button (Ctrl+RMB).

Note: You can set the no_dragpopup environment variable by choosing Setup – User Preferences from the Allegro PCB Editor menu bar and then choosing Input in the Categories section of the User Preferences Editor dialog box. By default, you must hold down the Ctrl key and depress the right mouse button at the same time when using strokes. Setting this environment variable lets you depress the right mouse button and drag the mouse when using strokes. With this option, however, you lose the ability to choose popup menu items by pressing the right mouse button and dragging the mouse. Instead, you have to click twice with the right mouse button: once to see the popup and a second time to select a popup item.
3. Draw the letter W with the cursor anywhere on the design.
This W stroke has been associated through the alias command with the zoom world command that zooms to fit the entire layout drawing on the screen.

4. Use Ctrl+RMB to draw the letter Z across an area of the board.

Allegro PCB Editor has associated the Z stroke with the zoom in command through the alias command. The extents of the zoom area are defined by the diagonal line connecting the upper left tip to the lower right tip of the Z. The Z stroke zooms into the area where you drew the Z.

5. Using the strokes listed below, experiment with the copy, move, and delete commands.

The move, copy, and delete strokes select the object under the first point of the stroke. Remember to click the right mouse button in the Design window and choose Cancel from the pop-up menu to inactivate a command.

<table>
<thead>
<tr>
<th>Stroke</th>
<th>Equivalent Command</th>
<th>Key Combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Ctrl + C</td>
<td></td>
</tr>
<tr>
<td>Move</td>
<td>Shift + F7</td>
<td></td>
</tr>
<tr>
<td>Zoom In</td>
<td>F10</td>
<td></td>
</tr>
<tr>
<td>Oops (Undo)</td>
<td>F3</td>
<td></td>
</tr>
<tr>
<td>Zoom World</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>--</td>
<td></td>
</tr>
</tbody>
</table>
Summary

You now know how to use mouse strokes to accomplish a task. You also know that you can use the Stroke Editor to create your own stroke file.

You have learned the following:

- **New terms:** stroke, Stroke Editor
- **New environment variable:** no_dragpopup
- **New console command:** stroke editor
- **New file:** allegro.strokes file

For More Information

See:

- the *Getting Started with Physical Design* user guide in your documentation set.
- *stroke editor* command in the *Allegro PCB and Package Physical Layout Command Reference*.
- *Allegro Design Entry HDL User Guide*

What’s Next

Go to Lesson 5-5: Scripting to learn how to record and play scripts.

Lesson 5-5: Scripting

Overview

You can use scripting for design setup and performing design functions. You can combine any sequence of commands in a script. Then you can use the alias or funckey commands to define shortcuts to replay the scripts. When you use the scripting feature, Allegro PCB Editor saves all your menu selections and mouse picks in a text file.
**Note:** The `funckey` command is available only in releases later than Release 15.0.

Macros are like scripts because they let you perform repetitive actions, such as complex geometric operations, on a drawing. The difference, however, is that scripts record from absolute coordinates while macros record from relative coordinate positions in a drawing, using the starting location you specify.

Two variables affect how scripts work. The `noformscriptbutton` environment variable lets the script use `add` or `reset` commands. The `script_keepformopen` environment variable keeps the script form open after completing the script. This can be useful when repeating a script several times. For information about setting environment variables, see **Lesson 5-3: Setting Environment Variables** on page 167.

In this lesson, you will learn how to perform these tasks:

- Starting a Script File Recorder
- Stopping the Script File Recorder
- Testing the Script File (colors.scr)

**Demo**

- **Scripting—Starting a Script File Recorder**
  
  This demonstration runs for approximately 2 1/2 minutes.

**Procedure**

**Starting a Script File Recorder**

1. With `cds_routed.brd` displayed in the Design window, choose *File – Script* from the menu bar.

   The Scripting dialog box appears.
2. In the *File* text box, type *colors*. Do not press the Enter or Return key.

3. Click *Record*.

   The Scripting dialog box disappears and you are ready to begin recording. Everything you do from this point forward is entered into the *colors.scr* script file. Notice the *Recording* status in the Status window.

4. Use one of these commands to display the Color and Visibility dialog box:
   - From the menu bar, choose *Display – Color/Visibility*.
   - At the console window prompt, type *color*.
   - At the icon toolbar, click 🟢.

5. Near the top right of the Color and Visibility dialog box, click on the *Global Visibility* drop-down list and choose *All Invisible*.

   When an alert message appears asking if you want to change all classes to invisible, click *Yes*. This action resets all the colors to *off*, so you can begin setting them to the colors you like.

6. In the Group drop-down list, choose *Components*.

7. Under the *Ref Des* class name, enable the visibility box for the subclass *Assembly_Top*. A check mark in the box indicates the subclass is turned *on*.

8. Choose *Geometry* from the *Group* drop-down list.
The Geometry groups are named *Board Geometry* and *Package Geometry*.

9. Under the *Board Geometry* group, enable the visibility for the *Outline* subclass.

10. Under the *Package Geometry* group, enable the visibility for *Assembly_Top*.

11. Choose *Stack-Up* from the *Group* drop-down list.

12. Enable visibility for subclasses in this group, as shown in the figure below, then click *Apply*, and then *OK*.

Notice the word *Recording* in the Status window. You are still in record mode.

### Demo

**Scripting—Stopping the Script File Recorder**

This demonstration runs for approximately 1 minute.
Procedure

Stopping the Script File Recorder

1. From the menu bar, choose File – Script to display the Scripting dialog box.

2. Click Stop to stop the script file from recording.

   All the modified visibility and color assignments are captured in the colors.scr file.

3. Click Cancel to close the Scripting dialog box.

4. From the menu bar, choose File – File Viewer to view the colors.scr ASCII file.

   The file is located in your working directory (proj2). Be sure to change the file type in the browser menu from (*.log) to All Files (*.*) so the colors.scr file appears.

5. Close the colors.scr file when you are done viewing it.

Demo

Scripting–Testing the Script File

This demonstration runs for approximately 1 minute.

Procedure

Testing the Script File (colors.scr)

1. Use one of these commands to display the Color and Visibility dialog box:
   - From the menu bar, choose Display – Color/Visibility.
   - At the console window prompt, type color.
   - At the icon toolbar, click 🐜.

2. Near the top right of the dialog box in the Global Visibility drop-down list, choose All Invisible.
**Allegro PCB Editor Tutorial**  
Module 5: Customizing the Environment

When a warning appears asking if you want to change all classes to invisible, click Yes.

3. Click OK to close the Color and Visibility dialog box.

Because the visibility for all classes is turned off, nothing is displayed in the Design window.

4. Use one of these commands to replay the script:
   - From the Scripting dialog box, type the name of the script in the File text box and click Replay.
   - At the console window prompt, type:
     ```
     replay colors
     ```

This command replays the script file you created, and automatically sets the visibility and color assignments.

**Summary**

You now know how to start, stop, and test a script.

You have learned the following:

- **New menu bar command**: *File – Script*
- **New console command**: `replay`
- **New environment variables**: `noformscriptbutton, script_keepformopen`

**For More Information**

See:

- the *Getting Started with Physical Design* user guide in your documentation set.
- `replay` command in the *Allegro PCB and Package Physical Layout Command Reference.*
What’s Next

Go to Lesson 5-6: Using Color Visibility Views to learn how to create and use a color visibility view and restore a previous view used in the current session.

Lesson 5-6: Using Color Visibility Views

Overview

A color visibility view saves the visibility of the Allegro PCB Editor classes and subclasses as a collection of layer visibility settings that you can apply to subsequent Allegro PCB Editor designs. You save the settings in a file that is stored in the current directory with a .color extension. A color view also displays film record visibility settings stored in the current design.

Demo

Using Color Visibility Views

This demonstration runs for approximately 3 1/2 minutes.

Procedure

1. Use one of these commands to display the Color Views dialog box and save a color visibility view:
   - From the menu bar, choose View – Color View Save.
   - At the console window prompt, type colorview create.
2. Click ... to browse to your current working directory where the cds_routed.brd file is located.

3. Type the name of the color visibility view, test, in the File name text box and click Save.


   If you choose either of the Partial view replacement methods, you must change visibility settings in the Color and Visibility dialog box (using the color command) or in the Visibility tab of the Control Panel.

5. Click Save and then Close.

6. In the Visibility tab of the Control Panel, turn off all the Conductor layers. Notice the changes in your drawing.

7. Use one of the following methods to restore the visibility layers you saved in the test file.

   ❑ In the Views list box on the Visibility tab of the Control Panel, choose test.

   Color views (.color files) appear in the Views list box as File: <name>. Film record names display appear as Film:
<name>, unless you suppress the film record names from
the list of color views in the Visibility window of the Control
Panel. Suppress these names by selecting the
color_nofilmrecord environment variable in the
colorview create environment variable in the
colorview load environment variable in the
colorview restore environment variable in the
control_panel control panel control panel control panel
section of the User Preferences Editor
dialog box. See Lesson 5-3: Setting Environment Variables
on page 167.

At the console window prompt, type colorview load
and then choose test in the Colorview Load dialog box.
Click Save.

The visibility layers are restored.

8. To toggle between the previous color visibility view and the one
you just created, use one of these commands:

❑ From the menu bar, choose View – Color View Restore
Last.

❑ At the console window prompt, type colorview restore

9. Exit the Allegro PCB Editor. Do not save any changes to
cds_routed.brd.

Note: You can also save or restore images, which are the same as
views except that they also include zoom points with the color views.
Use the images command at the Allegro PCB Editor console
window prompt.

Summary

You now know how to create and use a color visibility view, and
restore the previous visibility view used in the current session.

You have learned the following:

■ New term: color visibility view

■ New menu commands: View – Color View Save, View –
Color View Restore Last

■ New console commands: colorview create,
colorview load, colorview restore, images

■ New environment variable: color_nofilmrecord
New dialog box: Color Views

For More Information

See:

- the Getting Started with Physical Design user guide in your documentation set.
- colorview_create command in the Allegro PCB and Package Physical Layout Command Reference.
- colorview_load command in the Allegro PCB and Package Physical Layout Command Reference.
- colorview_restore command in the Allegro PCB and Package Physical Layout Command Reference.
- images command in the Allegro PCB and Package Physical Layout Command Reference.

You have successfully completed the Allegro PCB Editor Tutorial.
Appendix A: List of Demonstrations

This appendix is for on-line users who want to view the demonstrations. Click on a link below to view one of the Allegro PCB Editor demonstrations:

- Setting Your Working Directory and Opening a Design
- Discovering Allegro Platform Documentation
- Using the Command Browser to Access Help
- Using Other Methods to Access Help
- Identifying Parts of the User Interface
- Accessing Pop-Up Menus and Panning a Design
- Zooming In and Out of a Design
- Changing the Cursor Display
- Applying Colors to Classes and Subclasses
- Customizing Colors
- Modifying and Saving the Color Palette
- Controlling Etch Visibility
- Controlling Colors and Dimming Graphics
- Finding Objects by Type
- Finding Objects by Name
- Finding Objects by Property
- Highlighting Objects
- Listing Detailed Information About a Specified Object
Appendix A: List of Demonstrations

Measuring Distance Between Two Objects

Naming a Symbol and Setting Drawing Parameters

Setting the Grid for a Design

Creating a Board Outline

Choosing Drawing Options

Defining the Stackup

Associating Design Objects with Classes and Subclasses

Adding Arrows to a Design

Adding Circles to a Design

Adding Text to a Design

Using Zcopy

Customizing Your View and Toolset

Defining Aliases and Function Aliases

Setting Environment Variables

Running Commands with Strokes

Scripting—Starting a Script File Recorder

Scripting—Stopping the Script File Recorder

Scripting—Testing the Script File Recorder

Using Color Visibility Views